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WHAT’S NEW IN THIS ISSUE? 

The following sections in this revision of the document contain new information: 

• Section 4.1.1.4 The Survey History > Core Fields – the SurveyStatus options are re-ordered. 

• Section 6.1.5.4 The Surveys Started Not Completed Tab – the text and illustration is edited/added 

to include the survey link. 

• Section 6.3.2.4 Source Type > Survey – the description of the Additional Survey Variables field is 

edited. 

• Section 6.3.2.5 Source Type > BitStream Files is added. 

• Section 7.1.2.1 The Auto Elimination Tab is edited to include the Property Elimination field. 

• Section 7.1.2.3.5 How to Set the Property Elimination Function is added. 

• Section 7.1.2.3.6 How to Manually Exclude a Job is edited to include Survey Status. 

• Section 7.1.4.2 The Sub Sample Editor Page Data Fields – the Weight Parameter point is added. 

• Section 7.1.6.1 The Job Execution Area – a note is added to the text. 

• Section 7.1.6.2 The Job Reporting Area – the General Information point is edited. 

• Section 7.3 Job List - a Note is added to the text. 

• Section 7.7 Concurrent Sampling is added. 

• Section 7.8 Multiple Sample Upload is added. 

• Section 7.10.1 The General Tab – the Expected Return Variable point is added. 

 

Note: The general layout and language in this document is continually being corrected, adjusted 

and improved to ensure the user has the best possible source of information. Only NEW 
information and details that are changed since the previous issue are listed here - minor changes 
to the text, illustrations and layout are not listed. 
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1 Introduction 

Collecting feedback via the internet gives tremendous possibilities. You can interview your employees and 
your customers, and conduct surveys towards your markets, for example mapping the profiles of the 
people visiting your website. Within the Market Research industry, many agencies also use Panels to 
collect data and conduct research. 

A panel functions in the same way as a normal survey. Typically, a panel consists of mapping and profiling 

questions, and other categories such as work-related and household questions. The panelists register 
themselves in the panel, or you can import people directly into the panel if you already have their 
information. Based on the panelist information stored in the Panel (community), you can select appropriate 
respondents and invite them to participate in surveys. 

In Confirmit you can build a library of panelist interfaces, called Community Portals, through which 

registered and potential panelists can read about your panels and register themselves if necessary. Those 
who are already registered (members) can log into the Community Portal to answer new or previously 
started surveys, view their survey list, update their profile, view their points etc. All these actions are 
conducted via the same interface. 

A Panel can also be used by a company to hold information about its employees and/or customers. You 

can then send specific people surveys based on the information in the Panel. For example, if you want to 
send a seminar registration survey to all employees working in a particular city and a particular 
department, and who have not already attended that seminar, then the panel will give you a sample 
containing the people matching these criteria, and upload the list to the seminar registration survey. 

1.1 Recommended Limits 

Note: The Community Panels functionality includes no built-in limits. However, due to the time and 

resources used when processing large databases, you are strongly recommended to keep within 
the following maximum values: 

• Number of panelists – up to 10 million. 

• Survey history – up to 100 million records. 

• Maximum number of variables – the maximum number of variables on which Community Panels 
has been tested is 1500. 

• Sampling (Memory on batch server, read from BitStream server and SQL server) – a maximum of 8 
dimensions. 

• Maximum number of cells in the sampling matrix – 100.000. This is calculated by: the number of 
segments per dimension, multiplied (e.g. if the matrix has 8 dimensions, where the number of 
segments is n1 in dimension 1, n2 in dimension 2 etc. the total number of cells will be 
n1*n2*n3*n4*n5*n6*n7*n8) = max 100.000. 

• Be aware that large BitStream generations will use considerable server processing resources, and 
can cause delays for other users. Large BitStream generations should therefore be performed 
during off-peak hours. 

• BitStream file set generation affects the BitStream server during generation and sampling, and will 
affect the SQL server (reading) to a lesser degree. Therefore: 

− Limit the number of open text fields included when sampling. BitStream files should only include the 
fields to be used in filtering and sampling matrices, not the fields you need for the respondent file. 

− Open text fields that are to be part of the BitStream files should be limited to 4 characters. 

− Note that Open text fields are not supported as segments in the sampling matrix. 

− To optimize the panel database: use Boolean data types and numeric precodes whenever possible, 
and numeric ranges between 0 and 255 should be specified. 

Note: The actual limits will depend on the hardware configuration currently in use. Contact 
Confirmit Support for further information. 
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2 General Information 

2.1 How to Access Community Panels 

You have two ways of accessing the Community Panels functionality: 

• Go to the Home > Community Panels menu command. 

• Click the Community Panels item in the Quick Access pane. 

In both cases, the Community Panel List page opens. 

 

Figure 1: Example of the Community Panels List page 

This page lists the panels currently available to you. These may be panels that you have created or 
imported, or panels that others have created and given you permission to access. 

The panel details presented in this list are as follows: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by 
Confirmit when the panel is first created. This is the link used to access the panel. 

• Panel Name – the identifying name of the panel, given by the person who created it. 

• Company – the company registered as the “owner” of the panel. 

• Created By – the name of the person who created the panel. 

• Created – the date and time the panel was created. 

• Keywords – you can register key words for a panel to make it simpler to locate when the panel list 
is extensive. 

To open a panel, click on the blue Panel ID link. The Panel Overview page for the selected panel opens. 

2.2 The Search Facility 

In an established company the list of registered panels may run into thousands, and a search through the 

list for the one panel that you wish to use could be time-consuming. Confirmit therefore provides you with a 
set of filters so you can reduce a long list to a manageable size. 

• Panel Category – Click the down arrow beside the field to open a drop-down list of the panel 
categories, select the appropriate category from the list and click Search. The list is reduced to only 
those panels that have the selected category. 

Note: You do not need to type the entire name or number into the appropriate field – in most cases 
the first few characters will tend to reduce the list considerably. 

• Panel ID – type in part or all of the required panel’s ID number. 
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• Panel Name – type in the company name.  

• Company – allows you to search for jobs according to the company under which it is registered. 

• Created By – allows you to search for jobs created by specific users. 

• Created – Select an operator and a date to search for, for example any panels created on or before 
a certain date. 

• Keywords – type a key word into the field to search for all panels with that word registered as a 
keyword. 
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3 The Menus 

To open a panel, click on the blue Panel ID link in the Community Panel List. The Panel Overview page for 
the selected panel opens, and the Panel menus become available. 

3.1 The Panel Setup Menu 

The Panel Setup menu contains the menu commands required by the user while designing and editing the 
Community Portals database. 

Note: The design and creation of a Community Portal database is essentially the same as for a 

“normal” questionnaire database. This document therefore describes only the differences between 
a Community Portal database and a questionnaire database, and the additional procedures 
required. For further information on designing and creating a database, refer to the Confirmit 
Authoring User Manual. 

 

Figure 2: The Panel Setup menu commands 

The menu commands are as follows: 

• Designer – the database definition page. See section 4.1. 

• Database Generation – generates and updates the database. See section 4.2. 

• Community Panel Definition Export – export the database definition to another server. See 

section 4.3. 

• Designer Log – a “read-only” log of the main events occurring in the panel. See also section 4.4. 

• Active Languages – select the languages to be used. See section 4.5. 

3.2 The Panel Utilities Menu 

The Panel Utilities functions allow you to create and manage your panels. 

Once you have accessed the Community Panels functionality (see section 2.1) the Panel Utilities menu 

appears as shown in Figure 3. 

 

Figure 3: The Panel Utilities menu commands 

The menu commands are as follows: 

• Overview – provides general information on the selected panel. See section 5.1. 

• Project Log – logs activity on the project. See section 5.2. 

• Export Community Panel Definition – use to export Community Panel definitions to other 

Confirmit servers. See section 4.3. 

• Community Portal List – contains the commands you use to create and edit your Community 

Portals. See section 5.4. 

• Panel Activity Log – logs activity on the panel. See section 5.5. 

• Database Cleanup – removes deleted questions from the Panel database. See section 5.6. 

• Survey Sync – initiates a new task that checks all surveys associated with the current panel, and 
updates the panel if/when there are changes. This is to keep the panel data up-to-date so samples 
can be selected appropriately. This task can (should) be made recurring so it occurs automatically. 

See section 5.7. 
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3.3 The Panel Management Menu 

The Panel Management menu contains the commands used to create and edit the rules that define the 

panels and specify the panelists. 

 

Figure 4: The Panel Management menu commands 

The menu commands are as follows: 

• Single Panelist Editor – enables you to edit individual panelist’s details. See section 6.1. 

• Multiple Panelist Editor – enables you to edit the details of several/many panelists 

simultaneously. See section 6.2. 

• Current Rule – shows the details of the rule currently selected in the Rule List. See section 6.3. 

• Current Rule Set – provides details of the rule set currently selected in the Rule Set List. See 

section 6.4. 

• Rule List – displays a list of the available rules. Click on a rule to open it. See section 6.5. 

• Rule Set List – displays a list of the available rule sets. See section 6.6. 

• Virtual Variable List – lists virtual variables you have created to be used in aggregate queries to 

update the Panelist table based on information in the Survey History table. See section 6.7. 

3.4 The Sample Management Menu 

A Sample is a group of panelists selected from the panel using sampling criteria. The sampling criteria are 

set such that the sample is suitable to be respondents for a particular survey. For example, a sample 
selected to reply to a survey produced on behalf of a car manufacturer might comprise of males between 
the ages of 20 and 30 who live in a particular part of the country and who drive a particular make of car. 

The Sample Management functions allow you to create and manage samples. 

 

Figure 5: The Sample Management menu commands 

The menu commands are as follows: 

• Current Job – opens the Current Job window. This window provides general information about the 

selected job. Use this window to define and edit the criteria for the job. See section 7.1. 

• Current Matrix – this window shows the details of the matrix currently selected in the Matrix List. 

See section 7.2. 

• Job List – lists all the sampling jobs that you currently have “in progress”. See section 7.3. 

• Active Job List – lists all the sampling jobs that are currently “in production”. See section 7.4. 

• Matrix List – lists all the matrices currently available in your Confirmit database. See section 7.5. 

• Scheduling – lists the jobs that are awaiting execution and those that have been run. See section 

7.6. 

• Concurrent Sampling –  

• Multiple Sampling Upload –  

• Tester Template List – templates that enable you to add rows to the respondent database that you 
can then populate with “dummy” respondent information such that you can test the survey and the 

system setup before you send it out to the actual respondents. See section 7.9. 

• Sampling Settings – allows you to set default values and rules for the panel. See section 7.10. 

The following chapters in this manual describe the menu commands’ functionality, and the processes and 

procedures conducted via these menu commands. The menu commands are described in the order in 
which they appear in the menus. 
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4 The Panel Setup Menu 

The Panel Setup menu contains the menu commands required by the user while designing and editing the 
Community Portals database. 

Note: The design and creation of a Community Portal database is essentially the same as for a 

“normal” questionnaire database. This chapter therefore describes only the differences between 
the functions, procedures and properties available when creating a Community Portal database 
and those available when creating a questionnaire database. For further information on designing 
and creating a database, refer to the Confirmit Authoring User Manual. 

 

Figure 6: The Panel Setup menu commands 

4.1 Designer 

Select this menu command to open the Designer page. Use this page to create and edit the panel 
database. The page is divided into two main areas: 

• The Toolbox column – the toolboxes that appear in the left column in the Designer page provide 
an overview of the panel database and the objects available for use while creating or editing it. The 
toolboxes are displayed and available throughout the process. The toolbox is divided into two 
sections: 

− The Questionnaire Tree toolbox – shows the layout of the current database. Edit the database 
here, adding, deleting and/or moving objects as necessary. After any changes are made, the 

database must be re-generated (see section 4.2 Database Generation). Note that each “question” 

in the Questionnaire Tree will become a column in the database. 

− The New Objects toolbox – lists the objects you can use in the database. Drag and drop objects 
from here to the Questionnaire Tree. 

• The Question Details area – double-click on a question in the Questionnaire Tree to show the 
details of that question in the Question Details area. Use the tabs and data fields in this area to set 
up each question in the database. 

For further information, refer to the Confirmit Authoring User Manual. 

 

Figure 7: Example of the Professional Designer page 

4.1.1 The Questionnaire Tree Toolbox 

This toolbox is where you create and edit the panel database. 
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You build your database in the toolbox by creating Objects (questions, i.e. the database columns). All 

Objects placed between the survey name (here “User Manual Community Panel”) and the yellow “Sales 
and Lists” folder will be used in the database. The objects available are listed in the New Objects toolbox. 
The database columns will be listed in the order in which they are placed in this tree. 

4.1.1.1 How to Add an Object to the Tree 

There are four methods of creating objects: 

• Insert Inside – use to create the first question in a panel database, or to create an object inside 
another, typically folders. Right-click on the panel/folder name and choose Insert Inside, then 
select from the resulting list the object you wish to create. 

• Insert After – use to create objects in a project after an existing object. Right-click on the object 
after which you wish to create the new object, choose Insert After, then select from the resulting 
list the object you wish to create. 

• Drag and Drop – use standard Windows drag-and-drop techniques to copy objects from the New 
Object toolbox into the Questionnaire Tree. 

• Duplicate – copies an existing question. This would be useful if you have two or more questions 
that are similar in layout and/or content. Create and set up the first question, then duplicate it and 
edit the copy as required. 

You can use any of the above methods to create any object in the database. For further information, refer 
to the Confirmit Authoring User Manual. 

4.1.1.2 How to Delete an Object from the Tree 

To delete an object, select it and press the <DEL> key on your keyboard, or right-click on the object and 

select Delete from the menu. This will remove the selected objects from the routing, and set the Deleted 
flag on the objects to true. 

4.1.1.3 How to Undelete an Object 

If you delete a question from the tree and later wish to reinstate it, you can do this as long as the question 

has not been removed completely by the Database Cleanup function (see section 5.6 Database Cleanup). 

1. In the Questionnaire Tree, right-click on the Panel name text and select Show Deleted from the 

menu. 

This shows any deleted questions. 

2. Right-click on the question and select Undelete. 

Or 

Right-click on the question and select Properties from the menu, then uncheck the Deleted box in 

the questions Properties page. 

4.1.1.4 The Survey History > Core Fields 

These are the “default” fields that are always included in the database. The fields are as follows: 

• SurveyStatus – indicates the current status of the panelist in the survey. The options are: 

− Reserved – the panelist is selected for a job but the invitation email has not yet been sent (a short-
term status). 

− Invitation Sent – an invitation to participate in the survey has been sent to the panelist but the 
panelist has not yet accessed the survey. 

− In Progress – the panelist has started the survey but has not yet completed it. 

− Completed – the panelist has completed the job. 

− Stopped By System – the panelist has been screened by the system. 

• ReservedDate – the date the panelist was reserved for the job. 

• InvitationDate – the date the panelists are given access to the survey. 

• StartDate – the date the panelist first opens the survey. 

• CompletedDate – the date the panelist completes the survey. 
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• SubSampleNumber – refers to the sub-sample number code the panelist was selected under. 

• GroupNumber – refers to the group number code the panelist was selected under. 

• JobIsClosed – specifies whether or not the job is closed. 

4.1.2 The New Objects Toolbox 

This toolbox contains the templates for the objects that can be used in the database. Note that the range 
of options available here is much reduced from that available in the standard Confirmit Authoring. 

 

Figure 8: The objects available in the New Objects toolbox 

4.1.3 The Question Details Page 

The Question Details page is where you add text and answer options to the question. The functionality 

here is identical to that in a standard Confirmit survey. Refer to the Confirmit Authoring User Manual for 
further information. 

4.1.3.1 Question Properties 

The question objects in the Questionnaire Tree toolbox have a range of properties and settings that you 
can customized via the property sheets. The property sheet will always display the type and name/title of 
the active object. To open the Properties pane for a question: 

• In the Questionnaire Tree, right-click on the question and select Properties. 

Or 

• Double-click on the question or right-click on it and select Edit to open the Question Details page, 
then click the Show/Hide Properties button in the Details page toolbar. 

 

Figure 9: The Properties pane for a Single question 

Note: The Properties pane contains different properties depending on the type of question and the 
property selections made. The list below describes all the properties that may appear. 

The properties available are: 

• Field Width – specifies the number of characters assigned to responses to this question in the 
database and when exporting to fixed-width ASCII files. The default Field Width for Single 
questions is 32 characters. If the Field Width is not defined for an Open text question, it will be 
unlimited. If defined, the respondent will be prevented from entering more characters than the 
specified in Field width. 

• Indexed – if selected, an index is created on this field in the database the next time you generate 
the database. Indexes improve performance in areas such as 1) aggregated and verbatim reporting 
when filtering on fields with indexes, 2) searching in individual reporting and in survey data editing 
(when search fields are indexed), and 3) data imports where the key field is indexed. Note that 
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indexes should be used only when needed, as responses take longer to store the more indexes 
there are. This can lead to a performance reduction during interviewing. Also, the database will be 
unavailable for other processes the first time it is regenerated after the index property is set. 
Confirmit Support therefore recommends against setting new indexes and regenerating a survey 
while respondents are answering the survey. 

• Numeric – check to specify that the field shall only accept numerical characters. 

• Total Digits – specify the total number of digits the field can contain. 

• Decimal Places – specify the maximum number of decimal places allowed. 

• Lower/Upper Limit – specify an upper and/or a lower limit for the number. 

• Lower/Upper Limit Type – specify the limit type; either = or <=/>= as appropriate. 

• Data Write Access – this is the Write access permission level for the data in the database column. 

See section 5.1.2.3 for additional information. The options here are: 

− Low – all users with normal access permission can edit the data in this column. 

− Medium – only users with access levels Medium or High can edit the data in this column. 

− High – only users with access level High can edit the data in this column. 

• Boolean – applicable for Single questions. If selected, the question can have only two options, and 
the precodes must be 0 and 1. If you set an existing question to Boolean and that question had 
more than two answer options, then all the options except the first two will be deleted. 

• Characteristic – the group to which the data column is to be allocated. See section 4.1.3.2 below 

for further details. The options are: 

− Normal – columns for which you expect the majority of operations will be reading of the data 
contained. 

− Recoded – columns for which you expect the majority of operations will be writing of data. 

− Space Consuming – columns for which you expect the data contained will usually take a lot of 
space in the database, for example free-test fields. 

− Loop Support – defines a column as “Job-specific” information. Some information in the database 
is related to the survey job rather than to the specific panelist. When a number of panelists are 
selected for the same job, then that job information could be repeated for every panelist. To avoid 
expanding the database with repeated information, job-specific information is held in a separate 
section of the database. That section is then referred to for each panelist it applies to. 

• Date – defines the data from this open question (free text) as a date. The data in this column must 
then be in the specified format, and the system will expect it to be in that format so it will not need to 
analyze the data. 

• Accept Leading Zeros – check this box if you want the field in the expression builder to accept 
leading zeros. 

• Unique – check if every field in the column is to be unique. Use this for passwords, login names 
etc. 

• Deleted – will be checked if the question has been deleted from the Questionnaire Tree. Uncheck 

to undelete the question. See also sections 4.1.1.2 and 4.1.1.3. Note that you can view deleted 

questions by right-clicking on the Community Portal name in the tree and selecting Show Deleted. 
Deleted questions will then be shown “pale” until Hide Deleted is selected. 

Note: Some questions are required in a database by default, and these questions will be added 
automatically when you create a new database. As the information contained in these questions is 
required, some of the properties for these questions are not accessible and cannot be changed. 

4.1.3.2 Characteristic 

To improve accessibility and reduce processing times, the database is divided into sections. The sections 
group the columns together depending on the type of processing expected to be most usual in the 
columns. For example, for some columns most of the processing will involve reading the data contained, 
while for other columns most of the processing will involve writing data to the column. Other columns are 
expected to use a lot more file space than others, as a “free text” character uses eight times more space 
than a Boolean character. Use the Characteristic property to specify which group the column will be 
allocated to. 
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When the database needs to process information, it will go first to the group containing the columns with 

the appropriate characteristic. For example, if a database process is to write some data to a column, then 
the system will look for that column first in the Recode group. If the system finds the column in that group 
then it will perform the process. If it does not find the column there, then it will look in the other groups. 
This procedure will save considerable processing time, as otherwise the system must look through the 
entire database each time it needs to conduct a process. 

4.2 Database Generation 

This menu command activates the database generation function. The Community Panel database is used 
to administrate the panelists. If changes are made to the database, then it must be re-generated for those 
changes to be incorporated. 

This menu command only generates the database or regenerates it after changes have been made. To 

create or edit the database, go to Panel Setup > Designer as described in section 4.1 Designer. 

1. Go to the Panel Setup > Database Generation menu command. 

The page shown in Figure 10 is displayed. 

 

Figure 10: The Generate database Options tab 

2. Select whether you wish to generate a new database or update the existing database (if the 
database has not been generated previously then the “Update existing database” option will not be 
available). 

Note: If you select Update Existing Database, the database and the new data are checked before 
the update commences. In the event an error is found, then the process is stopped before any 
changes are made. If no errors are found then the new data will be added to the existing database – 
no existing data will be deleted. 

Note: If a database already exists for the project and you select Create New Database, the old 

database will be overwritten and any data in the old database will be deleted. 

3. Click Generate Database. 

The database is created/updated. A Task pane opens, containing a progress bar and a task status 

list. When the database has been generated, the text Task Completed will be displayed at the 
bottom of the task status list. 

In the event you have deleted questions from the database during editing, see also section 5.6 Database 

Cleanup. 

Note: Only the database is created; there is no web interview as in Confirmit Designer. Note also 
that in Community Panels there is no Test database available. 

4.3 Community Panel Definition Export 

You can export Community Panel definitions (the project coding) using XML. This enables you to transfer 
panel definitions from one Confirmit server to another. When you export a panel definition, the definition 
file is attached to an email, which is sent to the address specified in the Email Recipient field in the dialog 
box. 

4.3.1 How to Export a Panel Definition 

1. Go to the Panel Setup > Community Panel Definition Export menu command. 

The Survey Definition Export dialog opens. 
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Figure 11: The Survey Definition Export dialog box 

2. Check that the Email recipient is correct, type any comments into the Comment field as appropriate, 
then click OK. 

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the 
progress bar is at 100% and an OK button appears. 

3. Click the OK button to close the task page and return to the Community Panel List page. 

An email is sent to the specified recipient containing the project definition XML file. This file can now be 
imported into another server. 

4.3.2 How to Import a Panel Definition 

To import a panel definition that has been exported from another server: 

1. In the Confirmit Authoring Home page, go to the Home > Import Survey Definition menu 

command. 

The Survey Definition Import dialog opens. 

 

Figure 12: The Survey Definition Import dialog 

2. Browse to the XML file you wish to import, then click OK 

A Task pane opens, containing a progress par and a task status list. When the project definition file 
has been imported, the text Task Completed will be displayed at the bottom of the task status list. 

3. Click OK to close the Task pane. 

The panel will now be listed on the Community Panel List, accessed by going to the Home > Community 
Panels menu command. Once the panel is imported, you can import and attach a portal to it. 

4.4 Designer Log 

The system records actions executed on a project basis. Designer Log provides an overview of all 
changes that have been made on the project since it was first created. The system records the exact time 
when changes are made, the user who makes the changes, and specifies details of the change. 

This page is for information only. 

 

Figure 13: Example of the Designer Log page 
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4.5 Active Languages 

This menu command opens the Active Languages page. This page lists the languages selected for the 

Portal on the General tab. 

In the General tab you can select as many languages as required for the Portal, but while you are working 

in Community Panels, a maximum of five languages can be displayed at one time. This limit applies 
anywhere where the languages are listed, such as in the database question details pages. Check the 
boxes for the (up to five) languages you wish to show. To hide a language, click again to remove the tick. 

 

Figure 14: Example of the Active Languages pane 
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5 The Panel Utilities Menu 

The Panel Utilities menu contains additional utilities that will be useful to the designer while creating and/or 
editing the Community Portals database. 

 

Figure 15: The Panel Utilities menu 

5.1 Overview 

When you access a panel via its link in the Community Panels List, you come first to the Panel Overview 

page, General tab. 

Once you have selected a panel from the Community Panels List and are in that panel, then when you go 

to the Panel Utilities > Overview menu command the Panel Overview page for that panel opens. 

 

Figure 16: Example of the Panel Overview page for a panel 

This page provides general information about the panel, presented on three tabs. 

5.1.1 The General Tab 

5.1.1.1 The Main Area 

The information presented in this part of the page is as follows: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by 
Confirmit when the panel is first created and cannot be changed. 

• Panel Name – the identifying name of the panel, given by the person who created it. You can 
change the name here. 

• Company – the company registered as the “owner” of the panel. This can be changed here if you 
have the necessary permission. Click the down-arrow beside the field and select the required 
company name from the list. 

• Description – a description of the panel, for future reference. Type in text here. 
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• Languages – the language(s) selected for the panel. To add a language, select it in the Available 
column and click the >> button to move it to the Selected column. 

• Categories and Keywords – the keywords registered for the project as listed in the Keywords 

column on the Community Panels List page. See section 2.1. To add a keyword, select it in the 

Available column and click the >> button to move it to the Selected column. 

• New Keyword – use this field to add keywords to the Available list. Type the required word into the 
field and click Add. 

• Creator – the name of the user who created the project. This cannot be changed. 

• Created – the date and time when the project was created. This cannot be changed. 

• Status – the current status of the project. This is updated automatically as the project progresses. 

• Deployment – the type of deployment selected. 

• Enforce HTTPS… – check this option to enforce HTTPS use in Advanced Reporting, accessing 
reports via the Enduser interface, for this project. 

• Project Tasks button – opens the Task management page. See section 5.1.1.2 for further 

information. 

5.1.1.2 The Task Management Page 

To access this page, from the Panel Overview page General tab, click the Project tasks button. 

The Task Management page allows you to check the status of any tasks requested for this panel. 

 

Figure 17: Example of the task Management page 

The In the event the task list is extensive, you can search through the list using a number of parameters: 

• Task ID – the ID number given to the batch job by the system. 

• User ID – the login ID for the user initiating the task. 

• Project ID – the system-generated project number. 

• Schedule – you can filter tasks based on the schedule date (the date the task was initiated). 
Various formats of date input are allowed: '11/20/2007', '20 November, 2007', '11.20.2007 
14:45:23', etc. 

• Status – select a status from the drop-down list. 

• Task type – the type of task to be performed. 

• Recurr – you can search for recurring tasks only, for not-recurring tasks, or both types of tasks. 

For Completed and Aborted tasks, only the tasks run during the past 7 days will be shown. Completed and 

Aborted tasks that are older than 7 days are deleted. 

You can disable a task before it is executed or while it is being executed. To do this, tick the check-box 

next to the task and click Disable. Once a task is completed the checkbox disappears. 

Confirmit users who have Administrator permission to a project will be able to see and search for all batch 
tasks that have been set up for this project. 

Click on the Task ID number to go to the Task Instance Properties overview. Here is displayed information 
about the particular job’s Schedule, Status, percentage completed, Start time and End time, and the time 
used to perform the task. 
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Figure 18: Example of a Task Instances Properties window 

Go to the Log entries tab to view a complete overview for the job. 

 

Figure 19: Example of the Log tab 

Note: Confirmit sets a limit on the time a task can run before it is aborted. This is to avoid 
unnecessary strain on the server if there is an error in the file. However, this may also result in 
heavy tasks (for example based on long questionnaires) being stopped before they are completed. 
In the event this becomes a problem, ask your Confirmit administrator to adjust the time limitation. 

ASP only - Contact Confirmit Professional Services for assistance: support@confirmit.com 

5.1.1.2.1 Task Definition 

From the Task Instance Properties tab (see Figure 18), click on the Task Definition button to get an 
overview of the Recurrence pattern for the job. 

• Properties – provides general information on the selected job, and allows you to enter comments 
on the job. 

 

Figure 20: Example of the Properties tab 

mailto:support@confirmit.com
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• Recurr – once the settings have been saved, this tab displays the initial settings for the current job 
and the dates and times of any recurrences. To edit this, click the Change button on the Recurr 

tab. See section 5.1.1.2.2 for further details. 

 

Figure 21: Example of the Recurr tab 

• Instances – One job scheduled for execution can have several instances (recurrences). The 
Instances tab lists those recurrences that have been completed, and the next recurrence scheduled 
to be performed. Click on the link in the Schedule column to return to the Properties tab (see 

section 5.1.1.2) to check the details for each recurrence. 

 

Figure 22: Example of the Instances tab 

• Parameters – is for information only. 

 

Figure 23: Example of the Parameters tab 

5.1.1.2.2 Recurring Jobs 

A job can be set up such that it is repeated at regular intervals. 

1. From the Recurr tab (See section 5.1.1.2.1) click Change. 

The tab expands to show the additional properties. 

 

Figure 24: The expanded Recurr tab 

Here you can disable a task, give it a new start time, or set it to recur at regular intervals. 

2. To make the task recur, click the down-arrow beside the Recurring Task field and select Yes. 

The tab expands further as shown in Figure 25. 
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Figure 25: Setting up the recurrence times 

3. Set the options as required to create the desired recurrence pattern. 

4. On completion, click Save to save the changes. 

The tab reduces and lists the planned recurrences for the job. 

 

Figure 26: Example of the Recurr tab with planned jobs 

The job is added to the schedule in the Instances tab. 

 

Figure 27: Example of the Instances tab with a job scheduled 

 

5.1.2 The Permissions Tab 

The user who creates the panel is the panel administrator and owner, and a panel is initially invisible to all 
other Confirmit users. You can give access permission to other users via this tab. All Confirmit users in 
your organization will be listed in the tab, and you as the panel administrator may set up other Confirmit 
accounts with permissions to view the new panel. 

ASP only: Personnel at Confirmit may be granted access for support purposes. 
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Initially, only users and groups within your organization are listed on the page. Add other users by 

supplying Confirmit with the users’ correct user keys. 

 

Figure 28: Example of the Permissions tab 

5.1.2.1 How to Add Users to the Permissions Tab 

Typically, an external user will send you his or her user key by email. Paste this key into Confirmit as 
follows: 

1. Click the Add users button below the list. 

The Enter keys of new users dialog opens. 

2. Paste the new user’s key into the field and click Add. 

Note: Ensure there is no space after the last character in the user key. 

 

Figure 29: User Key Entry Window 

The dialog box closes and you are returned to the Permissions tab. The new user is added to the list under 
Other Users. 

You must now allocate the appropriate Permissions levels to the new user. 

5.1.2.2 How to Remove Users from the Permissions Tab 

To remove a user from the Other Users list: 

1. Click the Remove users button below the list. 

A dialog opens listing the users in the Other Users list. 

 

Figure 30: The Remove Users dialog 

2. Select the user or users you wish to remove from the list and click Remove. 
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Note: You can only remove users from the Other Users list. Users in the “Users in own company” 

list can only be added and removed by the company system administrator. 

5.1.2.3 Access Permission Levels 

The panelist data is held in columns in the database; one column for each “question” (see also section 4.1 

Designer). The data in the various columns can be viewed by any user, but can only be changed by a user 
if that user has the appropriate permission level for that column. Each individual column can have one of 
three access levels; Low, Medium or High, the level for the column being defined by the database designer 

in the Question Properties pane (see section 4.1.3.1). Each user is given access permission to one of 

these same levels here in the Permissions tab. 

• Normal – the default access level. Neither of the Data Access checkboxes is selected. The user 
can read all the data columns, and change data in columns that have Low write access. The user 
cannot change data in columns having Data Write Access Medium or High. 

• Data Access Medium – the Data Access Medium checkbox is selected. The user can read all the 
data columns, and change data in columns that have Low or Medium Data Write Access but cannot 
change data in columns having Data Write Access High. 

• Data Access High – the Data Access Medium and High checkboxes are selected. The user can 
read or change all the data columns. 

5.2 Project Log 

This accesses the same function as the Panel Setup > Designer Log menu command. See section 4.4 

Designer Log for further information. 

5.3 Export Community Panel Definition 

This accesses the same function as the Panel Setup > Community Panel Definition Export menu 

command. See section 4.3 Community Panel Definition Export for further information. 

5.4 Community Portal List 

5.4.1 Introduction 

In Confirmit you can build your own library of panelist interfaces (Community Portals), through which your 

panelists (and potential panelists) can read about your panels and register as new panelists. Those who 
have already become panelists (members) can log into the Community Portal to answer new or previously-
started surveys, view their survey list, update their profile, view their points, etc. All these actions are 
conducted via Community Portal List. 

A panel functions in the same way as a normal survey. Typically, a panel consists of mapping and profile 

questions such as demographic questions, work-related and household questions. The panelists register 
themselves in your Panel, or you can import people directly into your Panel if you already have their 
information. Based on their information inside the Panel (community), you can then recruit relevant 
respondents to specific surveys. A Community Portal is the interface (homepage) through which your 
panelists log in to participate in surveys, check their point status, change their profile, etc. 

Community Portals can only be used together with Confirmit Panels. 

5.4.2 Accessing Community Portals 

1. On the Community Panel List page, click on the appropriate Panel ID to open the Panel you wish to 

work with. 

2. Go to the Panel Utilities > Community Portal List menu command. 

The Community Portal List page opens. This page lists all the portals that you have access to. The 

current portal (if any) is shown in bold. 

3. To open a Community Portal in the Designer page, click on the Portal Name, or move the mouse 

pointer onto the Portal name to display a down-arrow button beside the name then click the button 
to display a drop-down menu. 
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Figure 31: Accessing a Community Portal for editing 

The menu options are: 

• Designer – opens the Community Portal Designer page. This menu command has the same effect 
as clicking directly on the Portal name. 

• Duplicate – makes a copy of the selected Portal. You can then re-name and edit the copy to make 
variations of the original. 

• Export – allows you to export a Community Portal to another Confirmit server. 

5.4.3 How to Add a Community Portal to your Panel 

A Community Portal can only be activated on a Confirmit Panel. You can do this in two ways: 

• Create a new Community Portal. 

• Add an existing Community Portal template to your panel (this is the most common approach). 

Note that the direct panelist link will be displayed under Panel Management together with the link to the 
panel registration survey. 

5.4.3.1 How to Create a New Community Portal for a Panel 

1. Go to the Panel Utilities > Community Portal List menu command. 

The Community Portal List page opens. 

2. Click the New Community Portal button located towards the upper-right corner of the page. 

The Properties dialog box opens. 

 

Figure 32: The Community Portals Properties dialog box 

3. Type a name for the new Community Portal into the Name field and click Next. 

The Select Template page opens, listing the templates available. Note that if you choose Finish 
here, then an empty Portal Designer page opens and you must create the portal. 

4. Select the desired template from the list and click Finish. 

The Community Portal Designer page opens with the new portal as defined by the selected 
template. Use this page and the toolbox provided to design and edit the portal as required. 

5.4.3.2 How to Import a Community Portal 

You can also import Community Portals created on other Confirmit installations. See section 5.4.6.1.6 for 

details on how to export a Community Portal. 

Note: You must first have a Panel into which the Portal can be imported. 

1. Go to the Panel Utilities > Community Portal List menu command. 

The Community Portal List page opens. 

2. Click the Import Community Portal button located towards the upper-right corner of the page. 

The File to Upload selection dialog box opens. 
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Figure 33: The File to Upload selection dialog box 

3. Click Browse to open a standard Windows file selection dialog. 

4. Browse to and select the portal file you wish to import, then click Open. 

The portal is imported to this Panel. 

5.4.4 Community Portal Languages 

The Community Portal pages and texts can be made available to the respondents in any language and 

any number of languages. 

5.4.4.1 How to Add a Language to the Portal 

1. In the Community Portal toolbox, right-click on the Portal name (the top item in the toolbox) and 
select Properties from the menu. 

The Properties page for the portal opens. 

 

Figure 34: The Properties page for the Portal 

2. Click the … button beside the Portal Languages property. 

The Portal Languages window opens with the currently selected languages listed in the Selected 
Items column. 
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Figure 35: The Portal Languages window 

3. In the Available Items column, scroll to the language you wish to add to the portal, and click on it to 
select it. You can select as many languages as you require. 

4. Click the >> button to move the selected language(s) to the Selected Items column. 

Select a language in the Selected Items column and click the << button to remove that language. 

5. On completion, click OK. 

The window closes and the selected languages are added to the Portal. 

Note: A search facility is available in the upper part of the window. If this is not visible, click the 

chevron button beside Find to open it. 

Text fields for the selected languages will now be available in the Portal and page Properties 

pages. You must now fill in the text fields for the Portal and the various pages for the languages you 

have selected. See also section 5.4.5.5.3 Page Properties. 

5.4.5 The Community Portal Designer 

The Community Portal Designer is where you create and make changes to your portal pages. In Figure 36, 

the Community Portal toolbox contains a Page Master, two Themes, and four Pages. In addition, there are 

three pages inside the Members Only folder (for more on Folders see section 5.4.5.5.4 Folders). 
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Figure 36: The Portal Designer toolboxes 

The Community Portal toolbox contains the Page Masters (see section 5.4.5.1 The Page Masters), 

Themes (see section 5.4.5.2 The Themes), and Pages (see section 5.4.5.5 The Pages). The Visual 

Components toolbox contains the elements that you can use on a page. Visual Components are explained 

in section 5.4.5.6 Visual Components. 

5.4.5.1 The Page Masters Folder 

A Page Master is a template that provides an overall look-and-feel to the pages in the Community Portal. 

You can create as many Page Masters as you need for a Portal. You can define one Page Master as the 
default, and this master will be applied to all pages in the Portal unless another Page Master is specified 
for that page. A portal page will always adopt the look-and-feel of the Page Master specified. 

5.4.5.1.1 How to Create a Page Master 

To create a new Page Master, right-click on the Page Masters folder name text beside the folder icon to 
open the drop-down menu, and choose Insert Page Master (Inside). A blank Page Master is added to the 
portal. If you want to base a new Page Master on an existing one, then right-click on the Page Master you 
wish to copy, and choose Duplicate. 

5.4.5.1.2 How to Edit a Page Master 

To open a Page Master for editing, double-click the name of the Page Master In the toolbox, or right-click 
on it and choose Edit. The page designer opens at the Layout tab. 
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Figure 37: Example of a Page Master 

On the Layout tab, you specify which Visual Components (page elements) are to be included on the page, 
and where they are to be located. 

To define the look-and-feel for each of the Visual Components, double-click the component or right-click 

on it and choose Properties. For more information on the Visual Components, see section 5.4.5.6 Visual 

Components. 

Go to the Preview tab to preview the current version of the Page Master. Remember to save any changes 

you may have done before previewing the Page Master. 

For more information on using HTML tables, free-from text, and images on your portal pages, see section 

5.4.6.2 Editing your Page Masters and Portal Pages. 

5.4.5.2 The Themes Folder 

A theme is a collection of different Styles, each holding a specific layout definition. Inside a Community 

Portal you can have as many themes as you wish, but only one can be active at a time. 

To set a theme as default, right-click on the theme and select Set as Default. Confirmit will display the text 
“DEFAULT” next to the default theme in the Community Portal toolbox. 

If you want the panelist to be able to select a theme, use a Theme Selector (see section 5.4.5.6 Visual 

Components). 

5.4.5.3 Styles 

Click the plus sign in front of each Theme to see all the styles for that Theme. Figure 38 shows the styles 
available in the Green theme. When Green theme is in use, the Visual Components (and free-form text) 
can be assign any of these look-and-feel definitions. 

To set a Style for a Visual Component: 

1. Double-click the component on the page, or right-click and choose Properties. 

The component Properties pane opens. 

2. One of the properties listed is the Style Name. Click the down-arrow button beside the property to 
open a drop-down list of the available styles, and select the required style from the list. 

3. Click Apply or Apply and Close to apply the change. 

4. On completion, save the changes. 
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Figure 38: Applying a style for a Visual Component 

Each style has its own set of properties as appropriate for the style’s requirements. Below is the properties 
pane for the pagetitle style. As this style is a “Text” component, it requires a number of font properties. 

 

Figure 39: Style properties 

When you change a setting, Confirmit provides an instant preview of the style so that you can see how 
each change affects the style. Also, when making changes to a style, each alteration (setting) is listed 

below the preview so that you can see which settings have been set for that style. Refer to section 5.4.5.6 

Visual Components for further information. 

5.4.5.4 View Stylesheet Contents 

You can view all the styles for a theme on one sheet. 

• Right-click on a Theme and choose View Stylesheet Contents. 

Confirmit will then list all the styles for that Theme. This can be useful if you want to quickly find the 
definitions of all styles, typically for use outside this theme. 
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Figure 40: View Stylesheet Contents 

5.4.5.5 The Pages Folder 

The third main folder inside the Community Portal toolbox is the “Pages” folder. This is where you set up 

the portal pages. 

5.4.5.5.1 How to Create a New Page 

To create a new page in the Portal: 

1. In the Community Portal toolbox, right-click on the Pages folder text to open a drop-down menu. 

2. Select Insert Page (Inside). 

Or: Right-click on an existing page and choose Duplicate. 

5.4.5.5.2 How to Edit a Page 

Double-click on a page in the Community Portal Pages folder to open the page for editing. The Community 
Portal Designer page opens for the selected page. This is where you select the Visual Components that 
are to be used on the page, and their positions on the page. 

A new page has been created in the Pages folder, called in this case Example Page (see section 5.4.5.5.1 

for details). This page will now be used to provide worked examples of the various procedures used when 
editing a page. 

On this page it has been decided to show some text (the text element), an external link, a link to the page 
called “Home”, and an image will be inserted across the bottom of the page. 

1. The first step is to set the Page Master (see section 5.4.5.1 for more information on Page masters): 

Right-click on the page and select Properties from the drop-down menu. The Properties pane 
opens. The first property in the list is Page Master. 

Right-click on the down-arrow beside the Page Master field to open a drop-down list of the page 

masters available, and select the desired page master from the list. 

If several languages have been defined for the Portal, then on this Properties page you can also 

type in translations of the title and description for the non-default languages. 

Save the changes. 
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As is shown in section 5.4.5.1.1 How to Create a Page Master, the element called “Page Area” 

determines where the page (portal page) is located on the overall page (Page Master). 

In other words, overall browser views are set up as Page Masters. The individual portal pages are 
set up under “Pages”, and you assign a Page Master for each page (if you do not, the default Page 
Master will be used). The portal pages will always appear on the screen where the Visual 
Component “Page Area” is located. 

2. Set the Page as Default / Login 

In the same way as one Theme is set to be default, one page is also set as the default page. This 
will then be the first page that the respondent sees when he/she goes to the Community Portal. In 
most cases this will be the starting page (home page). 

Right-click the page and choosing Set as Default. Confirmit will show the default page each time a 
new visitor enters the portals. 

The page you wish to use as the login page must also be specified. To do this, right-click the page 
and selecting Set as Login. Confirmit will display the text “LOGIN” next to the login page in the 
Community Portal toolbox. 

 

Figure 41: Setting the Login page 

5.4.5.5.3 Page Properties 

To open the Properties pane for a portal page, right-click on the page in the Community Panel toolbox and 
choose Properties from the menu, or when the page is open for editing click the Show/hide Properties 
button in the Editing pane toolbar. The properties pane opens alongside the page. 
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Figure 42: Example of a Page Properties page 

The page properties are as follows: 

Page Master – defines the layout for that page (see section 5.4.5.1 The Page Masters for more 

information). 

Name – the name of the page. You can edit this at any time. 

Protected – check this box if you want this page to be accessible only to people who are logged in. If a 
page is not protected all visitors can see the page. 

Navigator Item – defines when the page is to be visible in the menu bar (see also section 5.4.5.5.4). 

Visible – leave this box checked if you wish the page to be visible in the menu bar all the time. If the box is 

unchecked, then the page will not show. 

Visible when not logged in – leave this box checked if you want the page to be visible to all visitors to the 

site. Uncheck the box to hide the page from those who are not logged in. 

Title – the portal can be made available in any number of languages. These languages are selected when 

the portal is first created, or can be added later (see section 5.4.4 Community Portal Languages). The 

respondents can select the language (from the list available) in which the Portal is presented. The Title 
property provides one field for each language selected. Type into the fields the page titles in the various 
languages. 

Description – here you specify for each language the text you wish to appear when a respondent points 
to the page on their screens (mouse-over). 

5.4.5.5.4 Folders and Structure 

Folders are used inside the “Pages” section to create a menu structure for the portal pages. Each folder 
will create a clickable submenu for the panelists. 

To insert a new folder, right-click on an existing folder and select either Insert Folder (Inside) or Insert 
Folder (After) as appropriate. Once you have created the folder, create pages inside the folder or place 
them there using drag-and-drop. Note that you can have folders within folders. 

In Figure 43, note how the pages Example Page, Home, Join Community, FAQs, Contact Us, and About 
are displayed as separate pages on the menu bar. The folder “Members” creates a dropdown menu which 
leads to the pages inside the folder. The Lost Password page does not appear here because the Visible 
property in the page’s Properties page has been unchecked. The login page is only displayed when 
someone attempts to enter a restricted page. 



Confirmit Confidential  Confirmit Community Panels User Guide 

 

 

 30 

 

Figure 43: Using a folder to create a menu layout 

5.4.5.6 Visual Components 

The Visual Components are “prefabricated” elements you can use on the portal pages. Page Masters and 
“normal” pages have different sets of Visual Components available, reflecting the pages’ different 
functions. 

The procedure for inserting Visual Components is the same for Page Masters and Pages. Note that the 

Visual Components you insert into a Page will all be located within the Page Area component that is 
positioned on the Page Master. 

5.4.5.6.1 How to Add an HTML Table to the Page 

When you first create a page, it will be empty. To simplify the positioning of components on a page, it is 
recommended to first create a table on that page. You can then place the various components within the 
table cells, and use the cell properties to define the positions of the components. An existing page will 
normally already have a table. 

3. Double-click on the appropriate page in the Community Portal toolbox Pages folder, or create a 

new page. See also sections 5.4.5.1.1 and 5.4.5.1.2. 

The Page Editor for the page opens. 

 

Figure 44: The blank page editor 

4. Click the Table button  (A in Figure 45) in the page editor toolbar to open the table selector, 
move the pointer to the right and down until the required number of rows and cells are selected, 
then click in the lower-right selected square to create the table. 
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Figure 45: Creating a 3x3 HTML Table 

While working in the Portal Designer, a dotted grid is displayed as a visual guide so you can see 
the table boundaries while editing. The table will not be visible on the portal page. If you wish to see 
the page without this grid, either select preview, or click the Show/hide grid button (B in Figure 45). 

This table is used to define the positions of the components on the page. 

• Right-click in the table and select Table Properties from the drop-down menu to open the 
Properties page for the table. 

• Right-click in a cell and select Cell Properties from the drop-down menu to open the Properties 
page for the selected cell. 

• In the right-click menu you can also add and delete rows and columns for the table. 

5. On completion, click Save to save the changes. 

 

Figure 46: The resulting 2x2 table 

5.4.5.6.2 How to Add a Visual Component to the Page 

A page can include any number of visual components. From the Visual Components toolbox, which 
contains all the various page elements, we will now drag a component and drop it in the upper left cell. 

1. Go to the Visual Components toolbox, click on the component you wish to insert, and drag it up to 

the appropriate field in the table, or right-click in the appropriate cell and choose Insert 
Component. 
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Figure 47: Dragging a Visual Component into the table 

In the example, a Login Status component is being dragged into the upper-left cell of the table. On 
completion the Editing Page will look as shown in Figure 48. 

 

Figure 48: The table with the component in place 

You can now open the component’s, the cell’s and/or the table’s Properties pages and set up the 
component as required. 

2. On completion, click Save to save the changes. 

5.4.5.7 The Visual Components Toolbox 

Page Masters and “normal” pages have different sets of Visual Components in the toolbox, reflecting the 
pages’ different functions. The following sections describe all the components available. 

Each Visual Component has a Properties page that contains properties particular to that type of 

component. The Properties page enables you to select the characteristics for the specific component, and 
in many cases what information the component displays and how it is displayed to the panelist. To open 
the Properties page for a component, double-click on the component or right-click and select Properties. 
Refer to the Confirmit Authoring User Manual for further information on the properties. 

5.4.5.7.1 Page Area 

The Page Area component determines where the page (portal page) is located on the overall page. This 
component is only available for a Page Master. 
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Figure 49: A Page Master with the Page Area element 

5.4.5.7.2 Login 

The Login element displays the username and password text-fields and the associated Login button to the 

panelists. 

  

Figure 50: Example of the Login component in use 

5.4.5.7.3 Login Name 

The Login Name element displays the panelist’s username (normally the email address) after he or she 
logs in. In Figure 51, the Login Name element is being set up. Here, a custom text (Format String) is 
defined so when for example Peter Jones logs in with his username “peterj@firm.com”, the text displayed 
in the page becomes “Welcome peterj@firm.com!” 

The “username” is the only element that can be piped into the Login Name component. 

 

Figure 51: Setting up the Login name component 

5.4.5.7.4 Login Status 

The Login Status component allows you to place a hyperlink to a login page anywhere in your portal. This 
element is often used in combination with the property “Show Login Status When Logged In” on the Login 
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component. If this property is checked on the Login component, and the Login component is always 
displayed on screen (normally part of the Page Master), then the Login Status component may not be 
used. 

5.4.5.7.5 Password Recovery 

This component allows the panelist to ask that his or her password be sent to their email address. This 
requires that the panelist has previously registered. 

5.4.5.7.6 Change Password 

This component allows the panelist to change their password at any time. 

5.4.5.7.7 Navigator and Navigator Path 

The Navigator component determines where on the page the menu is displayed. The Navigator path 

component shows the panelists the history of pages visited. 

5.4.5.7.8 Language Selector 

If the portal is created in more than one language, then the panelists and other visitors to the site can 
choose which language the portal is presented in. In this case the selector is located in the upper left 
corner of the page. 

 

Figure 52: Example of the Language Selector in use 

5.4.5.7.9 Theme Selector 

If more than one theme is available to the portal, then the Theme Selector component allows the panelists 
and other visitors to choose which of the themes is used for their portal. In the example shown in Figure 
53, the selector is located in the upper left corner of the page (ringed) and the “Green” theme is selected. 

For more details on Theme, see section 5.4.5.2 The Themes. 

 

Figure 53: Example of the Theme Selector in use 
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5.4.5.7.10 Surveys List 

This component presents a list of the surveys the panelist is involved with, and can present additional 
information on each survey in the list. Each Surveys List component on a page can display one type of list, 
for example “All completed surveys” or “All surveys that are not yet started”. If you wish to present several 
types of list to the panelist, then you must add one Surveys List component to the page for each type of list 
you wish to present. 

5.4.5.7.11 Credit Balance 

Confirmit keeps track of points earned for panelist participation. Use the Credit Balance component to 

display the current number of points earned by the panelist. In the example below, when panelists go to 
the View Your Points page, they will see the sentence “You have N points in your account.” The variable N 
displays the credit balance, starting at zero. 

 

Figure 54: Example of the Credit Balance component in use 

5.4.5.7.12 Edit Profile 

Your panelists should have the opportunity to change their profiles. This component places a link on the 
portal page that, when clicked, takes the panelist to the survey they answered when signing up as a 
panelist. Here they can update their details so that when you next sample the panel for respondents for a 
particular survey, the group of respondents found for that survey is optimized. 

Note: You can use different surveys to update different parts of the panelist database. The link 

must then refer to the appropriate survey, so you must type the survey’s ID number into the Profile 
Survey ID field. 

 The survey will appear where the Edit Profile component is placed on the page. 

5.4.5.7.13 Edit Profile Link 

This is basically the same as the Edit Profile component, but takes the panelist away from the portal page 

and opens the registration survey in the window. Once the panelist has worked through the survey, it is 
closed and he/she is returned to the portal. 

Note: You can use different surveys to update different parts of the panelist database. The link 
must then refer to the appropriate survey, so you must type the survey’s ID number into the Profile 
Survey ID field. 

5.4.5.7.14 External link 

You can insert hyperlinks on your portal pages. Simply drag the Visual Component “External link” onto a 

page. Then double-click the element (or right-click and choose “Properties”) to set properties for the 
element. Inside properties you specify what URL you want this link to have. 

5.4.5.7.15 Link Target 

Use this component to embed an external link on a portal page. If/when the panelist clicks this link, the 

external site will open in the portal page. 

5.4.5.7.16 Text 

Use the Text component to display text on a portal page. As explained in section 5.4.6.2.6 Free Text you 

can enter text directly onto a page. If you do, such text will be the same for all panelists, regardless of 
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language. If you use the Text element, you can to specify text for each language selected for the portal, 
and Confirmit will display the text in the language chosen by the panelist via Language Selector (see 

section 5.4.5.7.8 Language Selector). 

5.4.6 Properties on a Community Portal 

To set properties on the portal level, right-click the portal name, and choose Properties. 

 

Figure 55: Properties on portal level 

The portal name is displayed on top of the property sheet. Inside Portal Languages you select which 
languages you want the panelists to pick and choose from. In our example we have selected English, 
Japanese, and Norwegian. As Default Language you specify which of the Portal Languages you want to 
use default. This language will be used as the first-entry language and whenever another language has 
not been chosen. Inside portal properties you can also state language-specific titles. These will be 
displayed to the panelists and other visitors. 

5.4.6.1 Managing your Community Portals 

You can create as many Community Portals as you require. However, only one portal can be publicly 
active at a time on each panel. You would normally build your portals inside the panels so that you have 
full control of how the portals will look. 

5.4.6.1.1 How to Publish a Community Portal 

Only one Community Portal can be published for a panel at a time. The published portal is the one used 
publicly for that panel. When a portal is publish, the Community Portal URL becomes available from the 
Project Management page > Overview tab. If another portal is published for the active panel, the new 
portal will override the old portal. 

Any changes you make to the Community Portal do not become public until the portal is published. 

To publish a portal: 

1. In the Community Portal toolbox, right-click on the portal name to open the drop-down menu. 

2. Choose Publish from the menu. 

5.4.6.1.2 Testing your Community Portal 

While working with the portals, you may need to test how different portals function together with your 

panel. Confirmit recommends that you have all relevant portals added to the panel. You can then try the 
different alternatives in Preview. 
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If you wish to make changes to a portal to for example try a different look or setup, you would probably 

save considerable time by duplicating an existing portal instead of creating a new one and starting from the 
beginning. 

5.4.6.1.3 Managing your Community Portal within your Panel 

To list all portals that are added to the active panel, go to the Panel Utilities > Community Portal List 
menu command in Confirmit. 

The list shows when each portal was created and by whom. The currently published portal for this panel is 
listed in bold, and the time when the portal was last published is also shown. 

5.4.6.1.4 Managing your Community Portal Templates 

The same Community Portal can be used on many different panels simultaneously. Whenever you save a 

portal as a template (see section 5.4.6.1.5 How to Save a Portal as a Template) the portal is stored as a 

general (global) portal template, which can later be added to other panels. 

A list of all such global Community Portal templates is found under the Home > Templates > Community 
Portal menu command. 

 

Figure 56: Community Portal template list 

When you enter a template, you can right-click on the template name and select Permissions from the 
menu. A list of all Confirmit users in your company is then displayed, so you can decide who in your 
company should have access to use this particular template. 

5.4.6.1.5 How to Save a Portal as a Template 

To save a portal as a template for later use, right-click on the portal name, and choose Save as Template. 
An identical copy of the current portal is then saved as a template. You can make changes to the copy or 
the original without the other being affected. 

5.4.6.1.6 How to Export a Community Portal 

If you wish to make a Community Portal available to another server, you can export it as an XML file. The 

file is then sent by email to a specified email address, whereupon the recipient can import it into the other 
server. 

1. In the Community Portal toolbox, right-click on the portal name and select Export from the menu. 

The Properties dialog opens. 

 

Figure 57: The Properties dialog when exporting a portal 

2. Type the recipient’s email address into the field, then click OK. 

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the 

progress bar is at 100% and an OK button appears. An email is sent to the specified recipient, with 
the compressed XML file attached. The recipient can then save and de-compress the file, then 

import it into the server. See section 5.4.3.2 for details on importing portals. 
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5.4.6.2 Editing your Page Masters and Portal Pages 

Note: Confirmit is not installed on your computer locally like an application such as MS PowerPoint 
normally is. In addition, no plug-ins or ActiveX components need to be downloaded for you to gain 
full functionality. Working in Confirmit means working 100% in a browser window. All formatting is 
done using HTML and style sheets. You use HTML table or style properties to position elements on 
the page instead of moving them to a precise point as in for example PowerPoint. 

The normal method of setting up a portal page (positioning the Visual Components) is to use HTML tables. 
A page can consist of one table or a combination of tables within tables. Place the various Visual 
Components (page elements) and images you wish to use, inside the appropriate table cell. 

Alternatively, you can specify each Visual Component’s position and layout by using style settings (CSS). 

See section 5.4.5.3 Styles for more information. 

5.4.6.2.1 Adding Rows and Columns to the Table 

You can add as many rows and columns as required to an HTML table. To add rows and/or columns, right-
click the cell within which you wish to add a row or column, and select Insert Row/Column from the 
dropdown menu. 

5.4.6.2.2 Deleting Table Cells, Rows and Columns 

To delete unwanted cells, rows and columns, right-click in the cell you wish to delete (or a cell in the row or 
column), and choose Delete Cell/Row/Column as appropriate. 

5.4.6.2.3 Table Properties 

To set the properties for the table, right-click anywhere within the table and select Table Properties from 

the drop-down menu. 

 

Figure 58: The Table Properties page 

The Table Properties page contains properties that are applied to the entire table. Note that similar 
properties are also available for the individual cells in the table, and if you set cell properties, then these 
will take precedence over the table properties. 

To set the background color of your table, type in the color code in the BackgroundColor text field, or 
double-click in the box to the right of the BackgroundColor property. A color picker chart then opens, from 
which you can choose a color. To activate your settings choose Apply or Apply and Close. 
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Figure 59: Editing the background color 

You can also specify the width and height of your table. The dimensions can be input as either pixels or 
percentage of the full screen. If you wish to use screen percentage, then you must type in the % character 
after the value. Otherwise, the setting will default to pixels. 

Have a look at the table properties above. Cell padding and cell spacing, as well as, borders are set in 
pixels. Cell Spacing is how far apart you want the cells to be within the table. Cell Padding is how far from 
the cell walls you want the text (or other contents) inside the cell to appear. 

5.4.6.2.4 Cell Properties 

To edit the properties of a cell, right-click in the cell and choose Cell Properties from the menu. The 
property box shown below will appear. 

 

Figure 60: Cell properties 

You can change the background color, width, and height as described in section 5.4.6.2.3 Table 

Properties. Be aware that changing these might influence the formatting or appearance of the other cells in 
the same row or column. 

If you wish to stretch a cell across more than one row or column, input values in the Colspan and/or 
Rowspan properties to specify the number of rows/columns you want the cell to span. 

5.4.6.2.5 HTML Mode 

When building your portal pages, you would normally work in WYSIWYG mode (what-you-see-is-what-

you-get). Users who are familiar with HTML coding can switch to HTML mode at any time. To toggle 
between the modes, click the Toggle Editor button at the left end of the toolbar. 

The figure below shows the table in HTML mode. You can at any time toggle back to WYSIWYG mode by 
clicking the same button. 
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Figure 61: Example of the HTML editing mode 

Note: When working in HTML mode, do not alter or remove the code that refers to Visual 
Components (page elements). 

5.4.6.2.6 Free Text 

You can type free text into a portal page by adding it to a table cell or directly to the page itself. You can 
also copy-and-paste text into the table cells. To further edit (format) your text, use the buttons in the 
toolbar. These are standard text-editing functions. 

Note: Common keyboard shortcuts can also be used, for example CTRL-B for bold, CTRL-U for underline, 
CTRL-I for italic etc. Enter inserts a paragraph break (<p></p>) and Shift-Enter inserts a line break 
(<br>). If you paste pre-formatted text into a page from other web pages or from a text editor application 
such as MS Word, the text will keep the formatting. 

5.4.6.2.7 Images 

You can insert images/pictures directly into a portal page. 

If you are in HTML mode (see section 5.4.6.2.5 HTML Mode) enter the HTML code (img tag) at the 

location where you want to insert the image. 

If you are in WYSIWYG mode you can copy and paste an image onto the page. You can also drag the 
image from a website or browser and drop it in the required position on a page. Be aware that if the image 
you wish to use is a hyperlink, then you must copy and paste it into the report, not drag-and-drop it, 
because dragging-and-dropping an image that is a link will result in the browser trying to open the page 
the link points to instead of pasting in the picture. In this case the images will not be moved to the Confirmit 
site, there will just be an image tag referring to the original location of the image. 

You can also right-click in a table cell and select Insert Image. This will open the property frame towards 

the right side of the screen, where you can specify source (the URL to the image), width, height, border, alt 
(alternative text, for use when image is not displayed), image alignment, and horizontal and vertical 
spacing. 

5.5 Panel Activity Log 

This page logs activity in the panel, primarily activity with Panel Rules and Sampling. 

An example of the page is shown in Figure 62. 

 

Figure 62: Example of the Panel Activity Log List page 

In the event the list is extensive, you can search it using a number of criteria to reduce it to manageable 
proportions. The search criteria are as follows: 

• From / To – The time and date is logged for every activity. Either type in or select the dates 
between which the activity that you are interested in occurred. 

• Status – the status of the activity. This can be: 

− All – shows all activities. 
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− OK – shows all activities that were concluded correctly. 

− Abort – shows only those activities that were aborted before completion. 

− Error – shows only those activities that were stopped due to an error. 

• Log ID – select an operator and type in a number to, for example, show all activities after a 
specified Log ID number. To reset, clear the field and click Search. 

• Username – type in the first characters of a username to show only those activities that were 
initiated while that user was logged on. To reset, clear the field and click Search. 

• Rule Set – type in the first characters of a rule set to show only those activities that included that 
rule set. 

• Batch/Manually – select Batch or Manually to show only those activities that were run as batch 
files or manually respectively. Select All to reset. 

• Activity Type – select the type of activity that you are interested in. 

Select the appropriate criteria and click Search. 

Once you have found the required log item, click a Log ID link to open the Log Details page for that item. 

 

Figure 63: Example of a Log Details page 

5.6 Database Cleanup 

When working with the database, if you delete a question (a column) and regenerate the database, the 
question and its data will no longer be visible or available in the database. However the data that was held 
in the column will not be removed from the database file in the first instance, it will merely be hidden. This 
is for two reasons: 

• With a large database the operation to delete the data will take a considerable amount of time and 
resources and will have a significant impact on the server performance during the time the deletion 
is in progress. It is therefore more practical to “save up” a number of deletion operations and run 
them simultaneously, thereby only causing one disturbance in the server instead of several. 

• If you should later wish to “undelete” the column, you can do this relatively easily while the data 

remains in the database (see section 4.1.1.3 How to Undelete an Object). 

Note: Once you have performed a Database Cleanup, the questions and associated data will be 

removed permanently from the database. You cannot then “undelete”. 

The Database Cleanup function completely removes deleted questions/columns, and the associated data, 

from the database. Once the data is deleted by the Cleanup function, if you later need that data then you 
must re-import it. 

1. Go to the Panel Utilities > Database Cleanup menu command. 
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The Database Cleanup page opens. This page contains a list of the questions that have been 

deleted from the database. 

2. Check the boxes beside those questions you wish to delete permanently from the database. 

3. Click Delete Columns. 

A confirmation box with the selected questions listed appears. 

4. Click Delete to remove the questions and data permanently from the database. 

5.7 Survey Sync 

The Survey Sync function checks all surveys associated with the current panel, and updates the panel 
if/when there are changes. This is to keep the panel data up-to-date so samples can be selected 
appropriately. 

For example: If a panelist is sent a survey and responds immediately, then the panel database can be 
updated such that the panelist is made available to be sent another survey. If on the other hand the 
panelist does not respond, then that person will not be available for further surveys until a predefined time 
after the current survey closes. 

1. Go to the Panel Utilities > Survey Sync menu command. 

The dialog shown in Figure 64 opens. 

 

Figure 64: The Launch Survey Synchronization Task dialog 

2. Type in a comment as appropriate, and select whether you wish to run the task as soon as possible 
or to schedule it for later execution. 

3. Click OK. 

If you have selected to run the task as soon as possible, then the task is added to the queue. If you have 

selected to run the task later, then the Recurrence Pattern dialog opens. See sections 5.1.1.2.1 and 

5.1.1.2.2 for further details on recurring jobs. 

5.7.1 Closing Surveys 

If a job arrives at its specified closing date and the survey to which the job is associated can be closed, 
Survey Sync will close the survey automatically. 

If an open survey is closed manually, Survey Sync will update the job such that it is no longer in 
production. 
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6 The Panel Management Menu 

This menu contains the functionality enabling you to edit panelist details and create and edit the rules 
employed to select samples from the panel. 

6.1 Single Panelist Editor 

This page lists the panelists registered in the database. In the upper pane, each panelist is presented as 
his/her response ID, in numerical order. In this pane you can specify the data columns that are to be 
displayed, and filter the list to focus on particular panelists. 

 

Figure 65: Example of a panelist list in the Edit window 

To select a panelist for editing, click the panelist’s Response ID number. The selected panelist’s details are 

then displayed in the Details pane in the lower part of the Confirmit window. See section 6.1.5 The Panelist 

Editor Tabs. 

6.1.1 Search 

The Search facility enables you to conduct a simple search through the list for the required panelist, 
though you must know the panelist’s Response ID. 

To conduct a search for a panelist, select an operator, type the characters of the required panelist’s 
Response ID into the data field, then click Search. 

6.1.2 Select Columns 

Click Select Columns to open a window that allows you to specify which database columns are to be 
displayed in the Panelist Editor window. 
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Figure 66: Example of the Select Columns window 

To select columns: 

1. In the Available items column, click on the data column(s) you wish to be displayed in the list, to 

highlight them. 

Note: In the event the database contains a large number of columns, use the built-in search facility 
in the upper pare of the window to reduce the list to a manageable size. 

2. Click the >> button to move the highlighted items over to the Selected Items column. 

3. Click OK. 

The Panelist Editor window is updated automatically when you click OK. 

6.1.3 Advanced Filter 

Use this function to mount an advanced search for panelists, using logical expressions based on selecting 

a combination of specific answers provided by the panelists in the database columns. 

1. Click Advanced Filter. 

The filter window opens. The left column will contain a list of all the database columns. 

 

Figure 67: Example of the Advanced Filter window 
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2. Click on an item in the left column to select it. 

In the event the list is extensive, type characters into the Search field to reduce the list to a 
manageable size to enable you to find the question you are looking for. Once you have selected a 
question in the first column, the second column shows the possible answers for that question. 

The number/text/date field and the available operators change to suit the selected item. 

3. Select or type in data as appropriate into the field. 

4. Click Add Here to add the selected data to the expression. 

5. Select the required operator, and again click Add Here to add it to the expression. 

6. Repeat the steps until the desired expression is built. 

7. On completion, click OK to apply the expression to the panel. 

8. Click Search. 

The list of panelists is reduced to show only those who answer to the expression. 

You can now more easily find the panelists you need to edit the details for. 

6.1.4 Clear Advanced Filter 

Click this button to clear the expression from the advanced filter and reset the list of panelists. 

6.1.5 The Panelist Editor Tabs 

6.1.5.1 The Details Tab 

This tab shows the details of the selected panelist. 

 

Figure 68: Example of the Details tab for a selected panelist 

To edit the details, click on the appropriate link in the Answer Text column. A separate Editing window 
opens. Here you can type in the new details. On completion, click OK to save the changes and close the 
window. 
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Figure 69: Example of a panelist details editing window 

6.1.5.2 The All Surveys Tab 

This tab lists all the surveys the selected panelist has been involved with. This list is basically a 

combination of the lists in the remaining tabs in this area of the window. 

6.1.5.3 The Completed Surveys Tab 

This tab lists all the surveys the selected panelist has completed. 

6.1.5.4 The Surveys Started Not Completed Tab 

This tab lists all the surveys the selected panelist has started but not yet completed. A link to the survey is 
provided. Click the link to open a new window with the URL to the survey, as shown in the example below. 
If you wish to view the survey, copy the URL into your browser. 

 

Figure 70: Example of the Survey Link window 

6.1.5.5 The Surveys Not Started Tab 

This tab lists all the surveys the selected panelist has been sent but has not yet started. A link to the 

survey is provided, as above. 



Confirmit Community Panels User Guide  Confirmit Confidential 

 

 

 47 

6.2 Multiple Panelist Editor 

Use this function to edit the details of several/many panelists simultaneously. Note that the same changes 

will be made to the details of all panelists selected using this method. 

When you go to the Multiple Panelist Editor, the page shown in Figure 71 opens. 

 

Figure 71: Example of the Multiple Panelist Editor page 

Note: If a rule already exists that will find the panelists you wish to edit (and only those panelists!), 
then you can click Select Rule and select that rule from the resulting list. See section 6.3 Current 
Rule for further information on Rules. 

To create a condition: 

1. Click Edit. 

The Expression Editor window opens as shown in Figure 72. 

 

Figure 72: Example of the Expression Editor window 

− The left column lists all the questions/columns in the panelist database. 

− The second column lists the possible answers for the question/column selected in the first column. 

− The third column lists the operators and functions available for the question/column selected in the 
first column. 

− The Expression area displays the expression as you build it, both as the entered code and as 
“explanatory text” below the Expression field. 

Note: If you have the necessary knowledge/information you can type the expression directly into 
the Expression field. However by doing this you risk creating errors that will prevent the 
expression from functioning correctly. In most cases, the most efficient method of creating the 
expression is by using the procedure described below. 

2. In the left column, find the question/column you wish to add to the expression and click on it to 

select it. 
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In the event the list is extensive, type characters into the Search field to reduce the list to a 

manageable size to enable you to find the question you are looking for. Once you have selected a 
question in the first column, the second column shows the possible answers for that question. 

3. In the second column, select or type in the answer you require. 

4. In the third column, select the required operator and function. 

5. In the expression area, click Add Here to copy the selected question and answer(s) into the 

expression. 

6. Repeat the procedure as required to build the desired expression. 

 

Figure 73: Example of an expression under construction 

7. Click Validate to check the expression does not contain errors. 

Note: Errors will not be possible if you use the method described here, but can arise if you type the 
expression directly into the Expression field. 

8. On completion, click OK. 

The Expression Editor window closes and the expression is copied into the Condition field in the 
Panelist Editor window. 

9. Click Save to save the changes. 

 

Figure 74: The Panelist Editor with the condition 

You now have the condition (ringed above) that will find the panelists that you wish to edit. You must now 
define which answer you wish to change for these panelists, and what you wish to change the answer to. 

10. In the Available column, find and select the answer column you wish to edit. 

11. Click the >> button to transfer the selection to the Selected column. 

12. In the Action field, type in the change you wish to make. 

Note: the syntax required here is the same as used in the Rule Editor functionality explained in 
section 6.3 Current Rule. 
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13. Click Save to save the changes. 

14. When you are sure the condition will find the required panelists, and the change you have specified 
is correct, click Execute to run the condition. 

The system now checks through the panel looking for any panelists answering to the condition. 

Note that in a large panel this may take some time. On completion, a dialog box opens indicating 
how many panelists have been found answering to the condition. 

 

Figure 75: Example of a search result 

15. If you wish to update the panelist records, click Update. Otherwise, click Cancel. 

6.3 Current Rule 

Rules are used to change data and move/copy it from one place to another. For example you can use 

rules to update the database. 

The Current Rule page shows the details of the rule selected in the Rule List (see section 6.5). When you 

select a rule in the Rule List, the Current Rule page opens at the General tab – see Figure 76. 

The following buttons are common for all the tabs in the page: 

• Back – takes you back to Rule list 

• Save – saves any changes made. 

• Duplicate – makes a duplicate copy of the rule. Use this if you need to make a rule that will be 
similar to an existing rule. You can then edit the copy. 

• Execute – once you have set up the rule and are sure it is correct, click this button to run the rule. 

• Validate Action Script – checks the script created in the Action tab to ensure there are no errors. 

• Export Rule – exports the rule so it can be imported into a different Panel server. 

6.3.1 The General Tab 

The Rule Details > General tab shows the details of the currently selected rule. Here you can change the 
rule’s Name, write in a Comment and set the Status. The remaining information cannot be edited. 

 

Figure 76: Example of the Rule Details > General tab 

• Status – select the required status for the rule. The options are: 
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− Enabled – select to allow the rule to be run “as required”. This is the default setting. 

− Disabled – select this option if you wish to prevent the rule from being run. This could be useful if 
you have a recurring task, and wish to stop using this rule in that task for a period but do not wish to 
change the task permanently. 

− One Run Only – select to specify that the rule is to be run only once. 

6.3.2 The Source Tab 

Use this tab to specify the data source on which the rule is to operate. The data to be moved or changed 
can come from a number of sources – select the Source Type, the screen layout thereafter depends on the 
Source Type selected. 

6.3.2.1 Source Type > Panel Database 

When you select Panel Database as the source type, the Source tab layout is as shown below. 

 

Figure 77: The Source tab with Panel Database selected as the Source Type 

• Expression / Edit – click to open an expression editor window so you can create an expression to 
select the data you wish to be manipulated. The functionality in this window is the same as that for 

the Multiple Panelist Editor. For further details, see section 6.2. 

• Survey History Variables – check this box only if exporting data and then if the result will be files, 
or if you wish to generate BitStream files. 

Note: When the Source Type is Panel Database and the Target is a File, you can format the values 
to be copied, for example the date format, field widths etc. 

6.3.2.2 Source Type > File 

Select this option if the data source is a file. The Source tab layout is then as shown in Figure 78. 
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Figure 78: The Source tab with File selected as the Source Type 

• Formatting – data is copied out as a text file. Select comma-separated or tab-separated as 
required. 

• Unicode – check this box if the file is saved as Unicode. The Code Page property is then disabled. 

• Locale – specify the area or country in which the data in the file is to be used. This will allow the 
system to format fields such as date fields according to local standards. 

• Code Page – select the code used in the file. 

1. Make the required settings, save them, then click Upload File. 

A File Upload dialog opens. 

2. Browse to and select the file to be uploaded, then click OK to load the file. 

After the file is loaded, the Mapping Setting button appears. 

3. Click to open the Mapping page. 

Field names in the uploaded file that are not the same as field names in the database must be 
mapped manually to the appropriate fields in the database. Any field names in the uploaded file that 
are identical to field names in the database will be mapped automatically. 

 

Figure 79: Example of the Mapping page 

4. Map any unmapped fields to the appropriate columns in the database. 

To do this, select the Unmapped File Field (ringed to the upper-right of the page), then select the 
Panel Database Field to which you want to map the File Field (ringed towards the left side of the 
page), then click Map Field (arrowed in the toolbar). Note that in this case, as the File Field is 
named the same as the Database Field, the mapping would have been performed automatically. 

5. On completion, click Back to return to the Source tab. 

6. Click Save to save the changes. 
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Note: If you have more than one BitStream data source in a panel and use rules to update them 
(see also section 6.3.4.1 Target Type > BitStream Files), then when you need to update one 
BitStream set it is very important that you update all of them. If this is not done, then the “not-
updated” BitStream files may be inconsistent and will then produce incorrect results. 

An example to illustrate the situation: 

Assume that you have two separate BitStream sets, A and B, and you have a number of sampling jobs 

working on each. When you run a sampling job on a BitStream set, this will cause the selected panelists to 
be noted in a table of “dirty” panelists – these are essentially panelists who have been selected for one or 
more jobs without the BitStream data source being informed (the BitStream data sources cannot know that 
a panelist has been selected for a job until the files are updated). When a sampling job is run, dirty 
panelists are detected by looking in the dirty table, so any panelists currently in the table will be checked 
and excluded/included as appropriate. If you now update BitStream set A, the panelists involved here will 
no longer be dirty, so will be removed from the dirty table. However BitStream set B has not been updated 
yet so still does not know about the dirty panelists. As these have now been removed from the dirty table 
they will not be noted, and there is a very real chance that when running another job on BitStream set B, 
panelists who should be excluded will be selected. 

6.3.2.3 Source Type > Database 

Select this option if the data source is a database. The Source tab layout is then as shown in Figure 80. 

 

Figure 80: The Source tab with Database selected as the Source Type 

• Connection String – the connection string used to connect to the database. 

• Table Name – to select entire table, write in the table name. Otherwise, define a Query String if you 
only want part of the table. Here you must use SQL syntax. 

6.3.2.4 Source Type > Survey 

Select this option if the data source is a survey. The Source tab layout is then as shown in Figure 81. 
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Figure 81: The Source tab with Survey selected as the Source Type 

Note: The Execute button is not available for this Source Type selection. 

Note: When you select Source Type to be Survey, on the Target tab the Target Type parameter 
must be set to Panel Database and the Target Mode parameter must be set to Update. See also 
section 6.3.4.4. 

• Survey Status – select the required option. Additional fields will be activated depending on the 
selection. All options and fields are described below. 

− Complete – selects only data from completed surveys. 

− Incomplete – selects only data from completed surveys. 

− Non-starters – selects only data from completed surveys. 

• Additional Survey Variables – type in the names of the questions you wish to retrieve from the 
survey, separated by comma. These fields can be used in the action script. To access the field in 
the script, the variables must be prefixed with ‘Survey.’. I.e. If you have selected interview_start as 
an Additional Survey Variable, you must write Survey.interview_start in the script to get the value 
for the current panelist. Click the Validate Action Script button to check the script. 

• Community Panel Variables –  fields selected here are retrieved and can then be updated. Any 
variables selected here will be listed in the Available Fields column on the Action tab (see section 

6.3.3). 

• Survey History Variables – the fields in the Survey History table. 

6.3.2.5 Source Type > BitStream Files 

Select this option if the data source is to be a BitStream file. The Source tab layout is then as shown 
below. 
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Figure 82: The Source tab with Bitstream Files selected as the Source Type 

• Datasource - this field contains a list of the available BitStream files. Select the required file to 
populate the Available list. In the figure above, Active Panelists is selected. 

• Expression / Edit – click to open an expression editor window so you can create an expression to 
select the data you wish to be manipulated. The functionality in this window is the same as that for 

the Multiple Panelist Editor. For further details, see section 6.2. 

• BitStream variables - select the required variables. 

• Survey History Variables – check this box only if exporting data and then if the result will be files, 
or if you wish to generate BitStream files. 

6.3.3 The Action Tab 

Use the Action tab to specify actions that are to be performed on the data. 

 

Figure 83: Example of the Action tab 
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Note: You are not required to enter information into this tab. Any scripting entered on this tab must 
be in JSCRIPT.NET format. Refer to MSDN.COM for further details. 

Fields selected in the Source tab (see section 6.3.2) are listed in the Available Fields column. These fields 

are available as Strongly Typed Properties in the script code. 

If you wish to change data, write the required action into the Action field. 

• Global Properties – you can define script properties that will be available to all records. They must 
then be defined here. 

• Global Script – Instantiate the variables defined in Global Properties. 

• Action – write in here the action that is to be run on the selected source records. 

6.3.4 The Target Tab 

Use the Target tab to select the target for the data defined in the Source tab (see section 6.3.2). The fields 

available on the Target tab depend on the Target Type that you select. 

6.3.4.1 Target Type > BitStream Files 

 

Figure 84: The tab when BitStream Files is selected 

• File Name – type in here the name of the BitStream file into which the data is to be copied. 

• BitStream Name – type in here the name that is to be displayed for the BitStream files 

6.3.4.2 Target Type > Database 

 

Figure 85: The tab when Database is selected 

• Connection String – type in here the connection string used to connect to the database. 

• Table Name – type in here the name of the table into which the data is to be copied. 

• Mapping Setting – you can map fields from the source to the fields in the database table. 

6.3.4.3 Target Type > File 

 

Figure 86: The tab when File is selected 
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• File Name – type in the name of the file the data is to be copied to. 

• Formatting – the data is copied out as a text file. Select comma-separated or tab-separated as 
required. 

• Set Export Field Name – you can change the names of the output columns. Click this button to 
open a mapping table, then define the new names for the columns. On completion, click Save to 
save the changes, then Back to return to the Target tab. 

• Locale – specify the area or country in which the data in the file is to be used. This will allow the 
system to format fields such as date fields according to local standards. 

• Send as Email – check this box if you want the data file to be attached to an email and sent. 

• Email Address – the email address to which the file is to be sent. 

Note: When the Source Type is Panel Database and the Target is a File, you can format the values 
to be copied, for example the date format, field widths etc. 

6.3.4.4 Target Type > Panel Database 

 

Figure 87: The tab when Panel Database is selected 

Use to update the database. 

• Target Mode – specify how the source data is to be added to the database. 

− Update – use if the source is a Panel database or if the Source is a file, and the file does include a 
Response ID column. 

− Import – use if the Source is a file, and the file does not include a Response ID column. 

− Import with key – use if the Source is a file, and the file does include a Response ID column. 

Note: When you select Source Type to be Survey (see section 6.3.2.4), on the Target tab, the Target 
Type must be set to Panel Database and the Target Mode must be set to Update. 

6.3.5 How to Duplicate a Rule 

To save time while creating a new rule, if you have an existing rule that is similar then you can duplicate it. 

1. In the Current Panel Rule page, click Duplicate. 

The Duplicate Panel Rule dialog opens. 

 

Figure 88: The Duplicate Panel Rule dialog 

2. Type in a name for the new rule, then click Finish. 

The rule is duplicated, and will appear in the Panel Rules list. The Panel Rule Details page opens 
showing the new duplicate rule. You can now edit the new rule as required. 

6.3.6 Validating an Action Script 

Click to check the script for compilation errors. If errors are found, they will be listed in a separate window. 

You must then correct the errors and validate again. 
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6.3.7 How to Execute a Rule 

run the rule to perform the specified changes etc. 

1. In the Current Rule page, click Execute. 

The Rule Execution Properties dialog opens. 

 

Figure 89: The Rule Execution Properties dialog 

2. Type any comments into the Comment field. 

3. In the Start Time field, select when you want the task to be run. 

Select ASAP to run the job as soon as it gets to the front of the task queue in the server. Select 
Schedule for Later Execution if you want the job to be run at a specific time in the future or if you 
want the job to be repeated at regular intervals. 

4. Click OK. 

If you have specified that the task is to run as soon as possible (ASAP) then a Task page opens 
showing a progress bar, the Task ID and the sequences being run and completed. 

If you have specified that the task is to be scheduled for later execution, then a Recurrence Pattern 

dialog opens. See section 5.1.1.2.2 Recurring Jobs for further details. 

On completion, the text Task Completed is displayed at the bottom of the sequence list. 

5. Click OK to close the Task page and return to the Panel Rule Details page. 

6.3.8 How to Export a Rule 

You can export rules to other servers and/or panels. Proceed as follows: 

1. Save the rule to ensure all changes/updates are included. 

2. Click Export Rule. 

The Export Rule dialog opens. 

 

Figure 90: The Rule Export dialog 

3. Edit the email address to which the rule is to be sent, and add a comment, as necessary. 

4. Click OK. 

An email is sent to the specified address with the rule attached. This rule must now be imported into 

the destination server. See section 6.5.2 How to Import a Rule for further details. 

6.4 Current Rule Set 

A Rule set is a number of rules that are to be run consecutively. The rules are run in the order in which 

they are listed in the set. Go to the Panel Management > Current Rule Set menu command to open the 
latest rule set selected from the Rule Set List. If no rule set has been selected during the current session, 

then the Rule Set List will be displayed (see section 6.6). 



Confirmit Confidential  Confirmit Community Panels User Guide 

 

 

 58 

6.4.1 The General Tab 

The Rule Set Details page opens at the General tab. 

 

Figure 91: Example of the Rule Set Details page > General tab 

• Rule Set ID – the identification number for the rule set. This number is generated automatically by 
Confirmit and cannot be changed. 

• Rule Set Name – the name given to the rule set when it was created/last edited. You can change 
this name as required. 

• Type – the type of rule set. The options are: 

− Ad Hoc – a rule set that is created for a specific use/event. 

− Recurring – a rule set created to perform a long-term job, that will normally recur at regular 
intervals. 

• Comment – a description of the rule set, to simplify identification. 

• Status – the status for the rule set. 

− Enabled – allows the rule to be run “as required”. This is the default setting. 

− Disabled – select this option if you wish to prevent the rule from being run. This could be useful if 
you have a recurring task, and wish to stop using this rule set in that task for a period but do not 
wish to change the task permanently. 

• Disable Sampling When Executing – check the box to prevent sampling being performed on the 
database while the rule set is being run. 

• Date information – for information only. 

6.4.2 The Rule Management Tab 

Use this tab to specify what is to occur in the event Confirmit discovers an error whilst the rule set is 
running. To set up the properties for a rule in the set, double-click on the rule in the left column to open the 
Details page. 
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Figure 92: Example of the Rule Management tab 

• On error – select the function you wish to occur in the event Confirmit discovers an error whilst the 
rule set is running. The options are: 

− Continue – select this option if you wish the rule set to continue running. 

− Stop – select this option if you wish the rule set to be stopped. 

− Jump to – select this option if you wish the current rule to be stopped and the rule set to jump to 
another rule. If you select this option, you must then select the rule to which the set is to jump, from 
the list below the “on error” options. 

6.4.2.1 How to Add a Rule to the Rule Set 

1. Go to the Panel Management > Current Rule Set menu command. 

2. In the Rule Management tab, click the down-arrow beside the Rule field to open a drop-down list of 
the rules available (once a rule is added to the set, it is removed from the list). 

 

Figure 93: Selecting a rule to add to the rule set 

3. Select the required rule from the list and click Add. 

The rule is added to the rule set. 

 

Figure 94: The rule added to the rule set 

4. Double-click on the rule to open its Details pane, then make the appropriate settings. 

5. On completion, click Save to save the changes. 
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6.4.3 The Report Tab 

This tab provides an overview of the contents of the various rules selected in the Rule Management tab. 

 

Figure 95: Example of the Report tab 

Click Printer and Save Friendly Version to open the report in a new window as a printer and save-
friendly version. 

6.5 Rule List 

Go to the Panel Management > Rule List menu command to display a list of all the rules in this panel. 

From this tab you can create new rules, and import rules from other panels. 

 

Figure 96: The Panel Rule List 

Click on a Rule Name link to open the Current Rule page for that rule. See section 6.3 for more 

information. 

6.5.1 How to Create a New Rule 

1. Click the New Rule Button towards the right end of the Panel Rule List toolbar. 

The Add New Panel Rule form opens at the General tab. Note that until you have named and saved 
the new rule, the other tabs in the form are inactive. 
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Figure 97: The Add New Panel Rule page 

2. In the Rule Name field, type in a name for your new rule. 

3. Type a comment/description into the Comment field so others can see what this rule is intended for. 

4. Select the status for the new rule. The options are: 

− Enabled – select to allow the rule to be run “as required”. This is the default setting. 

− Disabled – select this option if you wish to prevent the rule from being run. This could be useful if 
you have a recurring task, and wish to stop using this rule in that task for a period but do not wish to 
change the task permanently. 

− One Run Only – select to specify that the rule is to be run only once. 

5. On completion, click Save. 

The new rule is saved and will now appear in the Panel Rules list. The system allocates a Rule ID 

to the new rule, and this ID is displayed towards the top of the form. The form changes to the Panel 

Rule Details form (see also section 6.3), and the Source, Action and Target tabs become active. 

 

Figure 98: Example of the Panel Rule Details form 

6.5.2 How to Import a Rule 

You can copy rules to other servers or panels by using the Rule Export / Import functionality. See section 

6.3.8 How to Export a Rule for further details on exporting. Proceed as follows to import a rule into the 

current Panel or server. 

Note: The rule must be available as an .XML file (zipped or open) in a folder accessible from the 
current panel. The file will have been sent, attached to an email, from the originating server/panel. 

1. Go to the Panel Management > Rule List menu command to open the Rule List window. 
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2. Click the Import Rule button towards the right end of the toolbar. 

The Rule Import dialog opens. 

 

Figure 99: The Rule Import dialog 

3. Browse to and select the file. 

4. Type a name for the rule into the Rule Name field. 

5. Click OK. 

The rule is imported and added to the Rule List. 

6. Click on the blue Rule Name link to open the rule in the Current Rule window. See section 6.3 for 

further details. 

6.6 Rule Set List 

Go to the Panel Management > Rule Set List menu command to display a list of the rule sets available. 

 

Figure 100: Example of the Rule Set List 

Click on the blue Rule Set Name link for the desired rule set to select that rule set and open the Current 

Rule Set window. See section 6.4. In the event the list is extensive, use the search functionality to reduce 

the list to a manageable size. 

6.6.1 How to Create a New Rule Set 

1. In the Rule Set List window, click the New Rule Set button towards the right end of the toolbar. 

The New Rule Set dialog opens. 

 

Figure 101: The New Rule Set dialog 

2. Type the name of the new rule set into the field, then click OK. 

The rule set is added to the list. 

3. Click on the blue Rule Set Name link for the rule set to select it and open the Current Rule Set 

window. See section 6.4. Here you set up the rule set properties and add rules. 

6.7 Aggregated Variable List 

Aggregated Variables are variables specified by the user. These variables are used in aggregate queries 
to update the Panelist table based on information in the Survey History table. 
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Figure 102: Example of the Aggregated Variable List 

To open an Aggregated Variable, click on the blue Name link for that variable in the list. In the event the 
list is extensive, use the search functionality to reduce the list to a manageable size. 

6.7.1 How to Create a New Aggregated Variable 

1. Go to the Panel Management > Aggregated Variable List menu command. 

The Aggregated Variables window opens. 

2. Click on the New Aggregated Variable button towards the right end of the toolbar. 

The New Aggregated Variable dialog opens. 

 

Figure 103: The New Aggregated Variable dialog 

3. Type a name for the variable into the Name field, then click Finish. 

The variable is created and added to the Aggregated Variable List, and the variable opens for 
editing. 

 

Figure 104: Example of the editing page for an Aggregated Variable 

• Name – the name of the selected virtual variable. You can edit this as required. 

• Aggregate Operator – select the type of operator you wish to use. Options are: 

− Count – counts the number of rows in the table that satisfy the condition, and outputs the result. 

− Avg – totals the values in the table fields that satisfy the condition, and outputs the average value. 

− Min – examines the values in the table fields that satisfy the condition, and outputs the minimum 
value. 

− Max – examines the values in the table fields that satisfy the condition, and outputs the maximum 
value. 
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− Sum – totals the values in the table fields that satisfy the condition, and outputs the result. 

• Output Field Name – specify the field in the Survey History table that the condition is to be run on. 
Note that the fields available will depend on the Aggregate Operator selected. 

• Condition – click Edit to open a condition editor window, then create the required condition. See 

section 6.2 Multiple Panelist Editor for further details on the condition editor window. On completion, 

click Save to copy the condition to the Expression field. 

• Expression – the expression that will be used for the aggregated variable. This is arrived at by 
combining the selected Aggregate Operator and Output Field Name, and the Condition. 

• Comment – type in a comment or description for the variable. 

• Date information – for information only. 

Once you have created and saved the Aggregated Variable, it will be available for use in the Community 

Panel Variables field in the Current Rule > Source tab. See section 6.3.2.1 Source Type > Panel 

Database for further information. 
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7 The Sample Management Menu 

A Sample is a group of people who have been selected from a Panel to participate in a particular survey. 
The members of the sample will have specific characteristics that make them suitable for that survey. 

When a person agrees to be a panelist, they complete a questionnaire to provide their personal details and 

other information that the survey company (your company) may require. There could be hundreds of 
questions. These could include such details as where the panelist lives, whether they drive and/or own a 
car and if so what type, whether they have any children and if so how many, their ages, sexes, what types 
of schools they attend, whether they have any pets and if so what types etc. The panelist’s answers to 
these questions are entered into a database and later used to determine the panelist’s suitability to 
participate in a particular survey. For example, if a company that manufactures dog-food has asked for a 
survey to be conducted to analyze dogs’ preferences in a particular town, there is not much point in 
including a panelist who does not own a dog or who lives in a different town. 

Additional criteria, such as whether the prospective panelist has recently participated in a survey of a 
particular category, or participated in a survey of any category, within a specified period, can also be 
included in the sample selection process. These “exclusion” criteria will help to prevent panelists becoming 
overworked and perhaps bored with answering surveys. You can also use similar functionality to re-include 
potential panelists who were previously excluded automatically for other reasons. 

Confirmit’s Sample Management function uses the panelists’ details in the database and the additional 
criteria to select the appropriate panelists for a particular survey. 

The panelists that are selected for a survey are “booked” in the system for a defined period from the 
moment that the job for which they have been selected is executed. The selected panelists are flagged in 
the database, and will be available to be included in jobs that are executed later according to the mailing 
dates and exclusion rules for those jobs. 

The following sections in this chapter describe the functionality available through the Confirmit Sample 

Management menu, and the procedures required to make use of that functionality. 

Note: The Community Panel functionality may be purchased as a separate add-on module within 
Confirmit. 

 

Figure 105: The Confirmit Sample Management menu 

Click on Sample Management to access the sub-menu commands. The Job List is automatically 
displayed below the menu. Click on a job in the list to select it and go to the Current Job window. 

7.1 Current Job 

A sampling job is a group of sampling definitions with common properties that is to be scheduled and 

executed as one job. This produces a sample file as output, and some reports on the outcome of the 
sampling job. The sampling job will operate on a subset of the panel defined by a “global criteria” (a global 
filter, for example only panelists from a particular state). 

The Current Job window provides general information about the selected job. Use this window to define 
and edit the criteria for the job. 

To open this window, go to the Sample Management > Current Job menu command. The window 

contains six tabs: 

• Job Information – define the basic details for the job. 

• Exclusions – define any date-related automatic and manual exclusions, and manually relax 
exclusions that have been applied automatically. 

• Universal Criteria – create the background panelist-selection expression. 

• Sub Samples – A survey may need groups of respondents with different characteristics. The Sub 
Samples function allows you to create such groups. 

• Additional Items – specify which columns of information about the selected panelists are to be 
included in the resulting text file. 

• Execution & Reporting – confirm the panel selection and book the panelists for the job. 
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7.1.1 Job Information Tab 

This tab provides basic information about the current job. 

 

Figure 106: The Job Information tab 

7.1.1.1 The Tool bar 

• Save – click to save the changes you have made to the job. The button flashes while Confirmit has 
unsaved changes. 

• Duplicate – makes a copy of the current job so you can create a new job to the same 
specifications. You will be required to give the new job a different job number, and the Job Status 
will be reset to Work In Progress, but all other details will be identical to the original job. Once the 
job has been duplicated and given a new number, you can then edit the job as required. 

• Export Job – exports the job definition (not matrices) to a text file and sends the file to the stated 
email address. This function can be used by customers with their own servers to copy jobs from 
one server to another. 

• Validate Job – tests the job to ensure there are no logical inconsistencies that would cause the 
procedure to fail when the panelists are actually being selected. 

7.1.1.2 The Data Fields and Areas 

• Job Number – a unique identification number for the job. The number is generated when the job is 
first created, though it can be changed if necessary. 

• Job Description – a free-text description of the job to simplify identification later. You can edit the 
description at any time. 

• Job Status – the current status for the job. Change the job status in the Execution & Reporting tab, 

section 7.1.6. 

• Job Properties – you can define properties for the jobs (for example “Complexity”), and specify 

options for the property (for example “Low”, “Medium” and “High”) (see section 7.10.4). You can 

then specify the property and option for each job. These can then be used when eliminating 

panelists for jobs (see section 7.1.2.1 for further details). 

• External Fields – allows you to upload additional information on particular panelists. This 
information will be in the form of text files that must be created outside of Confirmit and uploaded. 
The files must contain the panelist’s ID and the extra information, and they must be uploaded for an 

individual panelist or for a group of panelists. See section 7.1.1.3.3 for further information on 

uploading files. 
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• Category – A panel’s category is specific to that panel. Use this area to define the category or 
categories to which the job is to apply. The Panel Categories list is a logical hierarchy of all the 

registered categories. See also section 7.10.3 The Categorization Tree Tab for further information. 

7.1.1.3 Procedures in the Job Information Tab 

7.1.1.3.1 How to Duplicate a Job 

1. Click the Duplicate button in the blue Job Information tab toolbar. 

The Duplicate Job dialog opens. 

 

Figure 107: The Job Import dialog box 

2. Type a unique job number for the duplicate job into the data field. 

3. Click OK. 

The new job opens in the Confirmit window, is listed in the Sample Management > Job List 

window under its job number, and can be selected and edited as required. 

7.1.1.3.2 How to Export a Job 

1. Click the Export Job button in the blue Job Information tab toolbar. 

The Job Export dialog opens. The default email address (that of the current user) is included as 
default in the Email Recipient field. 

 

Figure 108: The Job Export dialog box 

2. If necessary, change the email address to that of the intended recipient. 

3. Type a comment if required. 

4. Click OK. 

The new job opens in the Confirmit window, is listed in the Sample Management > Job List 
window under its job number, and can be selected and edited as required. 

7.1.1.3.3 How to Upload a File 

You can upload text files of additional information on panelists. 

Note: The file must be of .txt format and must be named matchfile.txt. 

1. In the External Fields area, click the Upload File link. 

The upload Settings dialog box opens. 

 

Figure 109: The Upload Settings dialog box 

2. In the dialog box click Browse. 
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A standard File Selection window opens. 

3. Browse to and select the required file, then click Open. 

The file path and name is added to the File to Upload data field. 

4. Click OK to complete the upload, or Back to change the selected file. 

7.1.1.3.4 How to Check the Job 

You can check the current job at any time during the construction process to ensure it will function 

correctly, and get a list of any errors or problems. 

1. Click the Validate Job button in the Job Information tab toolbar. 

An information dialog opens with a list of any errors or problems that the job may contain. 

 

Figure 110: Example of a verification message list 

You must now work through the list and correct the problems. 

2. Click OK to close the list dialog. 

Once all the errors have been corrected, when you click the Validate Job button the “Sampling Job 
is Valid” message box is displayed as shown below. 

 

Figure 111: The Job is Valid message box 

7.1.1.3.5 How to Select a Category 

If the Available Categories list is extensive or contains many similarly-named categories located in different 
branches of the hierarchy, you may wish to perform a search to locate the category you are looking for. To 
find panel categories: 

1. Type an appropriate combination of characters into the data field at the top of the Available 

Categories column. Wildcards are not necessary. 

2. Click Search. 

Confirmit will find and display all the instances of that combination of characters that are to be found 

in the Panel Categories hierarchy. 

For example if you type Product into the field and click Search, Confirmit will find all categories 

with the word Product anywhere in the category name. Note that you do not need to type in 
complete words. For example, type ll into the field and click Search to find all categories with ll 
anywhere in the name, such as any category with the word small in its name, or grill, or rolls…. 

If after typing in the first search criteria the list is still long, you can perform a search through the 
first set of results by repeating the procedure using other search criteria. 
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To reset the search filter and restore the entire hierarchy to perform a new search, click Clear. 

3. Once you have found the required category, click on it to select it, then click the >> button located 
between the columns. 

The selected category is moved from the Available Categories column to the Selected Categories 

column. 

Note: You can select as many categories as you wish. 

To remove a category from the Selected Categories list, click on it to select it and then click the << 
button located between the columns. The category is returned to the Available Categories list. 

4. On completion, click Save to save the changes. 

Note: The Save button flashes while the system contains changes that have not yet been saved. 

7.1.2 The Exclusions Tab 

You may wish to exclude potential panelists from a job for various reasons. For example you may wish to 

avoid using panelists who have recently been asked to reply to a survey of a particular category, or those 
who have recently been asked to reply to a survey of any category. The Exclusions tab enables you to set 
time-frames around the job’s planned mailing date, within which such panelists will be excluded. 

The Exclusions tab contains two sub-tabs: 

• Auto Elimination – panelists are excluded automatically if they conform to the general rules set 
here. 

• Manual Elimination – you can set additional exclusion rules and/or relax some rules. 

7.1.2.1 The Auto Elimination Tab 

The Auto Elimination function is controlled by dates. Here you can select the type of elimination you wish 
to use; Category and/or Date, and set the dates within which you wish the elimination rules to apply. 

 

Figure 112: The Auto Elimination tab 

The Auto Elimination tab controls three functions: 
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• Category Elimination – excludes potential panelists if they have the selected status and have 
been used in a sample for a survey of the same category within the specified dates. 

• Date Elimination – excludes potential panelists if they have the selected status and have been 
used in a sample for any survey within the specified dates. The panelist may have been invited to 
participate in a survey, they may or may not have responded to that invitation, or they may have 
already been included in a different sample for a survey that is still being planned. 

In both cases the exclusion dates are applied around the Mailing Date – the date on which you plan 

to email the survey invitations to those panelists who are finally selected. The darker shaded date is 

the selected Mailing Date (set at the top of the tab – see section 7.1.2.3.1), while the lighter shaded 

area covers the days selected in the Days Before and Days After fields for the appropriate 
calendar. 

• Property Elimination – a Property Definition (see also section 7.10.4) can be activated so it can be 

used in the elimination. This excludes potential panelists if they have the selected status and have 
been used in a sample for a survey with the same property within the specified dates. 

7.1.2.2 The Manual Elimination Tab 

You may wish to include some potential panelists in your survey who have been excluded by the Auto 

Elimination function, or you may wish to exclude panelists who have previously been involved with 
particular jobs, in addition to any exclusion generated by the Auto Elimination function. The Manual 
Elimination tab provides you with these possibilities. 

The tab is divided horizontally into two lists: 

• Available Jobs - the jobs currently registered in your database, which are available to be excluded 
or relaxed. 

• Selected Jobs – jobs selected from the Available Jobs list to be excluded or relaxed. 

To simplify management, the lists are automatically divided into “pages” with 30 jobs on a page. Scroll 

through the current page using the scroll bar at the right side of the list, and move through the pages by 
clicking on the Page arrow buttons at the lower-right corner of the list. 

 

Figure 113: Example of the Manual Elimination tab 

7.1.2.2.1 The Job Filters 

In an established company the list of registered jobs may run into thousands, and a search through the list 
for the one job that you wish to select for exclusion or relaxation could be time-consuming. Confirmit 
therefore provides you with a set of filters so you can reduce a long list to a manageable size. 

 

Figure 114: The joblist filter fields 

The filters are as follows: 
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• Category – this field lists the categories selected in the Job Information tab. Click the drop-down 
arrow to open the list and select the required category, then click Search. 

• Job Number – type in the number of the job you are looking for, then click Search. You can use 
wildcards and type in part of the number. For example, type in 123 to find all jobs where the job 
number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the 
number 123 somewhere in the job number, such as job number 45123678. 

• Description – type in the description of the job you are looking for, then click Search. You do not 
need to type in the entire description, and you can also use wildcards. For example, if the job you 
are looking for has the text “Confirmit Customer Survey 1” in the description field, typing in confirm, 
*sur, or even just *1 will find the job. However bear in mind that the simpler the search criteria is, 
the more jobs the search is likely to find. 

• Outgo – allows you to search for jobs according to the number of respondents who were invited to 
participate in the survey. Click the drop-down arrow beside the operator field and select the 
required operator, then type the appropriate number into the field to the right of the drop-down 
arrow. When you are ready, click Search. For example, select the <= operator and type in 1000 to 
list all the jobs that were mailed to 1000 people or fewer. 

• Mailing Date – allows you to search for jobs according to the date on which they were mailed. Click 
the drop-down arrow beside the operator field and select the required operator, then click on the 
calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the <= operator and a date to list all the jobs that were mailed on or before the selected date. 

7.1.2.3 Procedures in the Exclusions Tab 

7.1.2.3.1 How to Set the Mailing Date 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Elimination tab. 

3. On the Auto Elimination tab click on the calendar icon to the right of the Mailing Date field. 

The calendar opens. 

 

Figure 115: The calendar 

4. Using the arrow buttons, browse to the appropriate year and month, then click on the desired date 
to select it. 

Note that today’s date is highlighted in blue, and the selected date (if a date is already selected) is 

outlined. To close the calendar without selecting a date, click outside the calendar. 

When you click on a date, the calendar closes and the date is entered into the Mailing Date field. 

The time intervals you set in the fields lower in the window are then applied around the selected 
Mailing Date. 

5. Click Save to save the changes. 

7.1.2.3.2 Exclude All 

This check box is on the Auto Elimination tab. Check this box to exclude all panelists for all jobs. You can 

then go to the Manual Elimination tab and relax the exclusion for specific jobs. Use this function if you want 
to send for example a follow-up survey to the same panelists as for an earlier survey. 



Confirmit Confidential  Confirmit Community Panels User Guide 

 

 

 72 

7.1.2.3.3 How to Set the Category Elimination Function 

Note: Go to the Job Information tab to select the category(ies) with which this job is to be 
associated. 

If you wish to exclude potential panelists if they have been invited to participate in a survey with the same 
category(ies) as this survey, within a specified time period, proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Elimination tab. 

3. Check the Category Elimination box. 

The Category Elimination function is activated. 

 

Figure 116: The Category Elimination function 

4. In the Days Before… and Days After… data fields, specify the number of days which, if a panelist 
has been included in another panel of the same category during this period, they are to be excluded 
from this survey. 

5. Click the drop-down arrow beside the Survey Status field to open a list of the statuses and select 

the desired option. 

The options are: 

− Reserved – eliminates all potential panelists who are already reserved for other projects in the 
specified categories and date range. 

− Completed – eliminates all potential panelists who have completed a survey in the specified 
categories within the specified date range. 

− Invitation Sent – eliminates potential panelists if an invitation has been sent to them to participate 
in a survey in one of the specified categories. 

− In Progress – eliminates potential panelists if they are in progress with a survey of the specified 
categories. 

− Stopped by System – eliminates potential panelists who have been invited to participate in a 
survey in the specified categories during the specified time period, if those panelists have been 
stopped from completing those surveys by Confirmit. 

− All – eliminates all potential panelists who have been invited to participate in any survey of the 
specified categories during the specified period. 

6. Click Save to the save the changes. 

7.1.2.3.4 How to Set the Date Elimination Function 

If you wish to exclude potential panelists if they have been invited to participate in any survey within a 

specified time period around the mailing date for this survey, proceed as follows: 
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1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Elimination tab. 

3. Check the Date Elimination box. 

The Date Elimination function is activated. 

 

Figure 117: The Date Elimination function 

4. In the Days Before… and Days After… data fields, specify the period during which, if a potential 
panelist has been included in any other panel, they are to be excluded from this panel. 

5. Click the drop-down arrow beside the Survey Status field to open a list of the statuses. 

6. Select the desired option. 

The options are: 

− Reserved – eliminates all potential panelists who are already reserved for other projects in the 
specified date range. 

− Completed – eliminates all potential panelists who have completed a survey within the specified 
date range. 

− Invitation Sent – eliminates potential panelists if an invitation has been sent to them to participate 
in a survey within the specified date range. 

− In Progress – eliminates potential panelists if they are in progress with a survey within the 
specified date range. 

− Stopped by System – eliminates potential panelists who have been invited to participate in a 
survey during the specified time period, if those panelists have been stopped from completing those 
surveys by Confirmit. 

− All – eliminates all potential panelists who have been invited to participate in any survey during the 
specified period. 

7. Click Save to the save the changes. 

7.1.2.3.5 How to Set the Property Elimination Function 

If you wish to exclude potential panelists who are or have been involved with jobs with particular 

properties, proceed as follows: 

Note: This requires that the appropriate properties have been defined – see section 7.10.4. 

1. Go to the Sample Management > Sampling Settings menu command. 

The Sampling Settings window opens. 

2. Go to the Property Definitions tab. 

A list of the available Property Definitions is displayed, as shown in the example below. 
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Figure 118: Example of the Property Definitions list 

3. Click on the Name of the Property Definition you wish to use, to open the Property Definition page 
for that property. 

The page shown in the example below opens. 

 

Figure 119: Example of the Definition page for a property 

4. Check the Use In Elimination box, and other boxes as required. 

Note: Only one Property Definition can be used for elimination in a job. Once the Use In Elimination 
box is checked for a Property Definition, the box cannot be accessed for another definition. 

5. Click Save and close. 

6. Go to the Sample Management > Current Job menu command, then go to the Exclusions tab. 

7. On the Auto Elimination tab, check the Property Elimination box. 

Note that the Property Definition you selected in step 3 above is now named in the Property 
Elimination (arrowed in the figure below). 

8. Click Add. 

A row is added to the elimination list as shown in the example below. 

 

Figure 120: Example of the Property Elimination list 

9. Select the required item (in the figure above the Complexity property is selected, so the Item Name 
field lists the items registered for the Complexity property. In this case the Medium item is being 
chosen). 

10. Type values into the Days Before… and Days After… fields to set the date range for which the 

exclusion property is to be applied (the date range is applied about the Mailing Date). 

11. If panellists conforming to the property elimination should also have a specific status, then select 

the required status. 

Note: You can add as many rows as required to the list, and set them up such that all the required 
combinations of items, dates and survey statuses are covered. 

12. Save the changes. 
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7.1.2.3.6 How to Manually Exclude a Job 

If you wish to exclude potential panelists who have previously been involved in a particular job, proceed as 
follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Elimination tab. 

3. Go to the Manual Elimination tab. 

4. Using the filters as necessary, find the appropriate job in the list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Exclude button in the Available Job toolbar. 

The job is moved down to the Selected Job list, and is colored pink for easy identification. 

Note: You can exclude only those panelists in the job who have a specified Survey Status (you can 
specify more than one status). 

7. Click the … button beside the Survey Status field to open the Filter Survey Status dialog. 

8. Check the boxes for the statuses you wish to exclude (if None is selected, the other rows are 
grayed out), and click Save to save the statuses. 

The dialog closes and the selected statuses are added to the Survey Status field. 

9. Click Save to save the changes. 

Any potential panelists who satisfied the criteria in the selected job are now excluded from your current job. 
You can exclude several jobs at one time, and as many jobs as required. 

7.1.2.3.7 How to Relax an Automatic Exclusion 

If you wish to include in your current job potential panelists who have been involved with a particular job 
that has been excluded by the general criteria set in the Auto Elimination function, proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Elimination tab. 

3. Go to the Manual Elimination tab. 

4. Using the filters as necessary, find the appropriate job in the list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Relax button in the Available Job toolbar. 

The job is moved down to the Selected Job list, and is colored green for easy identification. 

7. Click Save to save the changes. 

Any potential panelists who satisfied the criteria in the selected job are now included in your current job. 

You can relax the exclusion notice for several jobs at one time, and for as many jobs as required. 

7.1.2.3.8 How to Deselect a Job 

You may wish to deselect a job that you have previously selected for exclusion or relaxation. Proceed as 
follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 
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The Exclusions window opens at the Auto Elimination tab. 

3. Go to the Manual Elimination tab. 

4. Find the appropriate job in the Selected Jobs list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Remove button in the Selected Jobs toolbar. 

The job is removed from the Selected Jobs list, and is returned to the Available Jobs list. 

7. Click Save to save the changes. 

7.1.3 The Universal Criteria Tab 

This tab is where you create the selection criteria expression that is the overall filter for the panelists. You 

can select criteria from the list and assemble them using the operators and functions, or if you have the 
required knowledge you can write the expression directly into the data field. 

 

Figure 121: Example of the Universal Criteria tab 

7.1.3.1 The Data Fields 

• Search – type a character or string of characters into the Search field. As you type, Confirmit 
reduces the criteria list to show only those criteria that include that character or series somewhere 
in the criteria name. 

• The Operators: 

− And – a conjunction operator to be used when more than one criteria must be satisfied. For 
example, the panelist must be male and must be married. 

− Or – a conjunction operator to be used when one or more criteria must be satisfied. For example, 
the panelist must have network access from home or from work. 

− None – this is not a conjunction operator. Use when adding the first criteria in the expression. 

− Not – the negative operator. Use for example when you want panelists who are not in banking 
though any other profession is acceptable. 

• The Functions (these will be active depending on the criteria selected): 

− Equal – use when you want the selected criteria to be equal to a specific value, for example when 
you want panelists of a specific age or you want the criteria to be Yes or No. 

− In – use when the criteria value is to be one of a range or set of values. 

− Between – use when you want the criteria to be between two values, for example between two 
dates. 

− > (Greater than) - use when the criteria is to be greater than a specified value. 

− >= (Greater than or equal to) - use when the criteria is to be greater than or equal to a specified 
value. 

− < (Less than) – use when the criteria is to be less than a specified value. 

− <= (Less than or equal to) – use when the criteria is to be less than or equal to a specified value. 
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− Contains – you can write an expression that looks, for example, for a certain combination of four 
characters anywhere in a line of text. 

− Left – you can write an expression that looks, for example, for the first three characters in a line of 
text. In this case select Left as the desired string is to be on the left end of the line. 

− Right – you can write an expression that looks, for example, for the last three characters in a line of 
text. In this case select Right as the desired string is to be on the right end of the line. 

• Other data fields 

− Text area – type text as required into this field. The field is only accessible for certain pre-defined 
criteria. 

− Paste area – here you can paste in, for example, a list of values copied from a document. 

− Number – here you can type in numerical characters only. Use in conjunction with a Function (see 
above) when, for example, you want a criteria to have a specific numerical value. The field is only 
accessible for certain pre-defined criteria. 

− End Number – when the Number field is open, if you also select the Between function, a second 
numerical data field appears. This enables you to input a second number such that you can specify 
the criteria must have a value between the two given numbers. 

7.1.3.2 Procedures in the Universal Criteria Tab 

7.1.3.2.1 How to Create an Expression 

Note: The procedures for creating expressions in the Universal Criteria tab and in the Sub Samples 

> Group Set tab > Expression Editor window are virtually identical. The only difference is that the 
Expression Editor window has Validate and OK buttons while the Universal Criteria tab has a Save 
button. The Universal Criteria tab is displayed in the main Confirmit window, so clicking Save 
checks the expression and saves the changes; it does not close the window. However as the 
Expression Editor function opens in a separate window, clicking OK checks the expression, saves 
the changes and automatically closes the window. If you then wished to make further changes to 
the expression, you would need to reopen the window before continuing. The Validate button is 
therefore included to allow you to check that the expression you have entered is valid before you 
click OK to save it and close the window. Therefore, if you are creating an expression in the 
Expression Editor window, click Validate to check the expression before you click OK to close the 
window. 

1. In the left column, search for or browse to the criteria you wish to start your expression with, and 
click on it to select it. 

Any options that may apply to the criteria will be listed in the second column. 

2. Select the radio button for the None operator (you cannot start an expression with the operators 
And or Or). 

3. Select the appropriate function and type any text or values into the Text or Number fields as 
required. 

4. Click Add Here (see the following figure) to add the criteria to the field. 

 

Figure 122: Adding criteria to the data field 

Note that the coding is displayed in the white data field while the logical expression is “written” 
below the field. 
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5. Select and add criteria until you have the required expression. 

6. Click Save to save the changes. 

 

Figure 123: Example of a complete expression 

7.1.4 The Sub Samples Tab 

Particular surveys may need groups of respondents with different characteristics. 

For example, you might want to create one group to reflect the people in one city with that city’s 
male/female ratio and income levels, and another group for a different city with that city’s male/female ratio 
and income levels. The Sub Samples function allows you to create such groups. 

To access this function, go to the Sample Management > Current Job menu command, then click the 

Sub Samples tab. 

This tab is divided into two areas: 

• The hierarchy column – displays the various sub-samples and group sets in a hierarchy. 

• The editor page –displays the details of the item selected in the hierarchy column and enables you 
to edit those details. 

Either right-click on an item in the hierarchy to open its right-click menu then select Edit, or double-click on 

the item, to open its editor page. 

 

Figure 124: Example of the Sub Samples Matrix List and Custom Codes page 
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Figure 125: Example of a Sub Sample hierarchy and an editor page 

7.1.4.1 The Right-Click Menu 

Place the cursor over an item in the hierarchy then click the right mouse button to open the right-click 
menu for that item. The menu commands available will depend on the type of item selected in the 
hierarchy. The full set of possibilities is listed below: 

• Edit – opens the editor page for the selected item. You can also open the editor page for an item by 
double-clicking on the item. 

• Add Group Set (Below) – creates a new Group Set below (within) the currently selected Sub 
Sample. 

• Add Group Set (After) – creates a new Group Set after the currently selected Group Set. 

• Add Sub Sample (Below) – creates a new Sub Sample below (within) the Sub Sample hierarchy. 

• Add Sub Sample (After) – creates a new Sub Sample after the current Sub Sample. 

• Refresh – refreshes the window to ensure all changes are displayed. 

• Expand All – expands the entire hierarchy. 

• Collapse All – collapses the entire hierarchy. 

• Duplicate – duplicates the selected Sub Sample and its underlying Group Sets and places the new 
Sub Sample at the bottom of the hierarchy. 

• Delete – deletes the selected item. You are asked to confirm the deletion. 

7.1.4.2 The Sub Sample Editor Page Data Fields 

• Name – the name for the sub sample. 

• Matrix – the matrix to be used to build up the group. Note that the matrix must be created first. 

• Cellweight – select the cell weight to be used by the Sub Sample. See also Original Cellweight 
below. 

• Original Cellweight – the customer might have specified a particular cell weight. However if not 
enough respondents can be found who satisfy the selection criteria, the cell weight might be 
changed to enable the job to be completed. In that case the cell weight actually used is given in the 
Cellweight field while the cell weight specified by the customer is given here. 

• Expression – the filter used to select the respondents. Click the … button to open the Expression 

Editor window. This window and its functionality are explained in detail in section 7.1.3.2.1. 

• Total target – this is the total number of panelists you wish to have in the sub sample Each group 
set in the sub sample is allocated its own target, and this total target is the total of the group set 
targets. Confirmit will attempt to fill this requirement while adhering to the selection criteria set in 
this and the other tabs. 

Note: Confirmit performs two series of checks while creating a sample. The first check is 
performed using the criteria defined in the sampling job (using the Universal Criteria expression 
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and exclusions), then a second check is performed to ensure any required percentages, 
weightings etc. are met. If Confirmit finds more than the required number of panelists that comply 
with the criteria then the program will randomly select the total required from those found. If not 
enough panelists complying with the criteria in the first check can be found, then an error message 
is displayed and the job will stop. If you wish to continue with the job you will then have to change 
some of the criteria. If the first check finds enough panelists but the second check cannot meet the 
required percentages, weightings etc. then Confirmit will try to complete the job by making 
adjustments to the weightings and percentages. Any changes will be notified in the job report. 

• Default Code – you can define a code number for each group. If a respondent is found who 
satisfies the general criteria but who does not fit into a specific group, they will be allocated this 
default code. 

• <custom code> - if a custom code is defined in the sub-sample (see section 7.1.4.3.2), then it will 

appear here. Add a value as required. 

• Weight Parameter – this property is only used during concurrent sampling (see section 7.7), and is 

only visible on the Sub Sample Editor page if the Expected Return Variable box is set to a value 

other than None (see also section 7.10.1). The property enables you to specify the accuracy of the 

sampling by using the probability that panelists are likely to reply to the survey. Enter a value 
between -1 and +1. A value of -1 will allow the sample to include panelists who have a low 
probability of replying. This will thereby result in a larger sample to ensure the required number of 
responses are returned. A value of +1 will restrict the sample to only those panelists who have a 
high probability of replying to the survey. This will thereby result in a sample closer in number to the 
required size. 

• Disable Balancing – a particular matrix can be used for many jobs. Check this box if you do not 
want to use the cell weights applicable to the matrix. 

• Discard Default Group… – check this box if you do not wish to use potential respondents who 
have been allocated the default code number (see above). 

7.1.4.3 Procedures in the Sub Samples Tab 

Note: Double-click on an item in the hierarchy or right-click on it and select Edit, to open the item’s 

editor page. 

7.1.4.3.1 Adding a Matrix List 

A panel can have a large number of matrices available for use. When you are setting up a group of sub-
samples you may only need a small selection of the available matrices. Use the Matrix List functionality to 
build a “short list” of the matrices that are to be available for the sub-samples. These matrices will then 
appear in the drop-down list beside the Matrix field shown in Figure 126. 

To add a matrix to the drop-down list, click the Add Matrix button and select the required matrix from the 

full list. 

7.1.4.3.2 Adding a Custom Code 

You can define one or more variables for which you can specify values in the Sub-Sample and Group 
levels. When you add a custom code, it appears in the sub-sample / group window with the name you 
have given it. If you add values to both the Sub-Sample and Group levels, then the Group level takes 
precedence. 

7.1.4.3.3 Adding a Global Custom Code 

You can define a variable and a value that will be given to all panelists who are selected for the output file. 

Type in the name for the global code and give it a value. If you wish to add more codes, click the Add Row 

button. 

7.1.4.3.4 How to Create a New Sub Sample 

1. Click on the Sub Sample icon after which you wish to create the new sub sample. 

2. Click the right mouse button. 

The right-click menu opens. 

3. Click Add Sub Sample (After). 
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A new sub sample is created after the current sub sample, and its details window opens (see 

Figure 126). 

4. Type the name for the sub sample into the Name field, and fill in the remaining details as 
appropriate. 

5. Click Save to save the new sub sample. 

Note: You can also select Duplicate from the right-click menu to make a copy of the currently 

selected Sub Sample and its underlying Group Sets. 

 

Figure 126: Example of a sub sample editor page 

7.1.4.3.5 How to Create a New Group Set 

The Group Set function allows you to create a number of groups with similar characteristics. Each Sub 

Sample in the hierarchy can contain any number of Group Sets, and each Group Set can contain any 
number of groups. Once a group set is created you can edit the characteristics for each group individually. 

1. In the hierarchy column, right-click the Sub Sample into which you wish to add a new Group Set, 
then from the right-click menu select Add Group Set (Below). 

The Group Set Editor page opens. 

 

Figure 127: The Group Set Editor page 

2. Type the desired name for the new group set into the Group Set Name field. 

3. Click Save to save the changes and apply the name. 

Note: The new Group Set already contains one undefined group. If you only require one group in 
the Group Set then you need only to fill in the details for this group. In this case, click in the data 
fields under Target and Code and type in the appropriate details – see below for the field 
descriptions. 

4. If you wish to create more groups, click Generate Group. 
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The Generate Groups window opens. 

 

Figure 128: Example of the Generate Groups window 

5. Fill in the details. The fields are as follows: 

− Number of Groups – the number of groups you wish to create in this operation. 

− Group Start Code – each group should have a code number. The number series will be created 
automatically but the system needs to know where to start. Type in here the first code number to be 
used. 

− Group Increment – The code numbers can be set to increase in increments, for example in steps 
of 10 (10, 20, 30 etc.). Type the required increment in here. 

− Percent – if you want to use a percentage of the total number of suitable people found by the filter 
instead of a set number, check this box. See also Target below. 

− Target – the total number of people you want to have in the group, or the percentage of the total 
number of people found by the filter. For example, if the filter finds 500 suitable respondents for the 
group and you type in 50 here, the system will randomly pick out 50 people. If you type in 50 here 
and also check the Percent box then the system will randomly pick out 50% of 500 = 250 people. 

6. Click Generate to create the new groups. 

The new groups are added to the Group Set list. 

7. Click Save to save the changes. 

The following figure shows the Group Set editor page with the new groups created according to the 
parameters set in the Generate Groups window in the previous figure. 

 

Figure 129: Example of the new groups 

You can edit the group details as required. Click in the data field and make the necessary changes. On 
completion, save the changes. 
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7.1.5 The Additional Items Tab 

When a person first agrees to make themselves available as a potential panelist, a lot of details about that 

person are registered into a database. The database is constructed as a table of rows and columns where 
each row contains the details of one person. 

The end product of the panel selection process is a text file containing a sample of the database table 
rows (panelists’ details) as defined by the exclusion and selection criteria. Use the Additional Items tab to 
specify which columns of information about the selected panelists are to be included in the text file. The 
columns included here will define the contents of the results tables that will be available after the survey is 
completed. 

Some information, such as the panelist’s ID number is always included by default, but otherwise you can 
select from the list of available data columns those that are to be included. 

The Template Fields area below the main columns lists any columns that are included by default due to 

the template that is in use. See section 7.10.5 The Output Field Templates Tab for further information. 

 

Figure 130: The Additional Items window 

7.1.5.1 The Additional Items Tab Toolbar 

The toolbar for the Additional Items tab is as shown below. 

 

Figure 131: The Additional Items toolbar 

• Search – starts the search function. 

• Add – moves selected fields from the Available Fields list to the Selected Fields list. 

• Add All – moves all the available fields from the Available Fields list to the Selected Fields list. 

• Field Type – select the field type you wish to use. The options are: 

− Panel fields – the fields pre-defined by the panel. 

− Data fields – additional fields made available by uploading a matchfile.txt file. See section 

7.1.1.3.3. 

• Check box – click in a check box to select the associated field. The uppermost check box selects 
all the fields. 
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• Field name – the header for the list of fields in the column. 

• Remove – removes selected fields from the Selected Fields list. 

• Remove All – removes all fields from the Selected Fields list. 

7.1.5.2 Procedures in the Additional Items Tab 

7.1.5.2.1 How to Add Fields to the Selected Fields Column 

1. In the Available Fields column click in the check boxes to select the desired fields. 

Selected fields are shaded blue for easy identification. 

If for example the majority of fields are required, click in the check-box immediately below the 
Search button to select all the fields, then use standard Windows techniques and deselect those 
that are not required. 

2. Click Add. 

The fields are moved to the Selected Fields column. 

Click Add All to move all the fields to the Selected Fields column. 

7.1.5.2.2 How to Remove Fields from the Selected Fields Column 

1. In the Selected Fields column, click in the check box to select the field you wish to remove. 

Selected fields are shaded blue for easy identification. 

2. Click Remove. 

The fields are moved to the Selected Fields column. 

Click Remove All to return all the fields to the Available Fields column. 

7.1.5.2.3 Searching for Field Names 

If the Available Fields list is extensive, you may wish to perform a search to locate the field name or names 

you are looking for. Proceed as follows: 

1. Type an appropriate combination of characters into the Field Name data field. Wildcards are not 
necessary. 

2. Click Search or press the Return key on your keyboard. 

Confirmit will find and display all the instances of that combination of characters that are to be found 

in the Available Fields column. 

For example if you type Zip into the field and click Search, Confirmit will find all fields with the word 
Zip anywhere in the field name. Note that you do not need to type in complete words. For example, 
type ll into the field and click Search to find all fields with ll anywhere in the name. 

If after typing in the first search criteria the list is still long, you can perform a search through the 

first set of results by repeating the procedure. 

3. Once you have found the required field, click in its check box on it to select it, then click Add. 

The selected field is moved from the Available Fields column to the Selected Fields column. 

Note: You can select as many fields as you wish. 

To remove a field from the Selected Fields list, click in its check box to select it and then click the 

Remove button. The field is returned to the Available Fields list. 

4. On completion, click Save to save the changes. 

Note: The Save button flashes while the system contains changes that have not yet been saved. 

7.1.6 The Execution & Reporting Tab 

Once you have set up all the selection criteria for the job, the job must be executed. You have a number of 
options for this procedure: 

• You can test the settings by performing a dry run (the database is not updated and the panelists are 
not reserved). 
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• You can perform a “real” sample selection procedure with or without final reports. 

• You can define when you want the execution job to be performed, and whether or not you want the 
job to be repeated at specified intervals. 

• You can add test recipients (Tester Templates – see also section 7.9 Tester Template List). 

Once the job has been executed, you can also: 

• Upload the output file into a project (see section 7.1.6.4.1 How to Upload the Output File). 

• View a snapshot of the panelists in the sample (see also section 7.1.6.4 After the Job has been 

Executed). 

 

Figure 132: The Execution & Reporting tab 

The Execution and Reporting tab contains two main areas: 

• The Job Execution area. 

• The Job Reporting area. 

7.1.6.1 The Job Execution Area 

This shows general executing and reporting information about the job. The toolbar contains a number of 

buttons and the area contains two check boxes. 

• Save – saves changes to the tab. The button flashes while the tab has unsaved changes. 

• Execute Job – starts the job execution process. Once the job is executed for the first time, 

additional buttons become available – see section 7.1.6.4 After the Job has been Executed for 

further details. 

Note: Once you have clicked the Execute Job button, it is deactivated while the job is running. This 
is to prevent “multiple-clicking” and the job being executed several times by mistake. 

• Preapproved – Confirmit can be set up by the system administrator such that an executed job 
must be approved by the user’s manager before it can be mailed. Check this box if you wish to 
avoid that procedure, for example for testing purposes. 

• Disregard in Future Eliminations – check this box if you do not want the panelists selected by 
this job to be excluded from future samples by the time limits set in the Exclusions tab. Use this for 
example if you want to send an information email to a group of panelists without affecting their 
validity to be selected for future questionnaires. 
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7.1.6.2 The Job Reporting Area 

This area lists the jobs that have been executed. It provides access to the reports for those jobs, and also 
allows you to go directly into the Rapid Results functionality so you can see how the results will look when 
they are included in a report. 

• Job Definition Report – click this button to display a report of the job definition. This report 
contains three sections: 

− Job Details – the job number, status etc. 

− General Information – the job categories, the expression and exclusions used, and the additional 
items selected. Note that exclusions are sorted by job number. 

− Sub Sample Information – details of the sub samples defined. 

Click the up or down arrow buttons in the header rows to show or hide the information lists, and 
click the green Back Arrow button to close the window and return to the Execution & Reporting 
window. 

 

Figure 133: Example of the Job Definition Report window 

• Outgo Report – click the appropriate link to open the job execution report. This report shows the 
details of the selected panelists. 
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Figure 134: Example of the Outgo Report window 

The buttons and other details are as follows: 

− Back – click to return to the Executing & Reporting tab. 

− Printer Friendly version – opens a new window containing a version of the report that is set up for 
printing. 

− Sub Sample – use this to filter the sub sample details that you want to be displayed. Select 
between the various sub samples that are included in the job, or All. 

− The Summary Report list – shows the results for the sample selection process. The H/L 
(High/Low) column shows the difference between the Actual result and the Target (Actual – Target). 

− The Crosstab Report list – you can build simple tables to analyze the generated samples using 
the same data as the Outgo Report. 

Click in a table header to toggle the show/hide function for that table. 

• Recreate Respondent File – regenerates the output file to include new columns, but without 
selecting new panelists. A task pane opens to provide information while the recreation task 
progresses. On completion, click OK to return to the Execution and Reporting window. This button 
is only available once the job has been executed. This could be used for example if you have 
created an output file but need to add or change variables. 

7.1.6.3 Procedures in the Execution & Reporting Tab 

7.1.6.3.1 How to Execute a Job 

1. In the Execution & Reporting tab, click Execute Job. 

The Execute Job Properties dialog box opens. Use the options available in this dialog to select the 

desired type of result. 
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Figure 135: The Execute Job Properties dialog box 

• Job ID – the identification number of the selected job. This is for information only and cannot be 
changed. 

• Update Panel – ensure this box is checked if you wish to create a sample and update the 
database. This action will reserve the selected panelists for the job, ensuring they cannot be used 
for other jobs during the exclusion periods. 

Click in the box to deselect it if you wish to perform a “dry-run” of the sample selection process. 
Confirmit will then apply all the expressions and exclusions, will check the system setup, and will 
present a report with all the appropriate information, but no changes will be made in the database 
and the panelists will not be reserved. Use this to test the job setup to ensure you get the required 
panel. You can perform as many dry-runs as you wish. 

Note: If you execute the job with the Update Panel option selected, you can remove the panelist 
reservations from the database afterwards. To do this, click the Remove Job from Panel button that 
appears in the tab’s toolbar. 

• Generate Output File – ensure this box is checked if you require the output file (the list of panelists 
reserved for the job) to be created. 

Note: If you select to create the output file but not to update the panel database, then Confirmit will 
have no record that the selected panelists have been involved with this job. These same panelists 
may then be included in later jobs, and will not be excluded automatically by date and/or category. 

Comments – type any comments into the free-text data field. 

• Start Time – click the down arrow to open a drop-down list of the options available: 

− ASAP – start the job as soon as possible. The job will be queued behind any other jobs awaiting 
processing in the database, and will be run as soon as the processor is available. 

− Schedule for later execution – select this option if you want to run the job execution procedure at 
a later time. If this option is selected, when you click OK, a dialog opens in which you can set the 
required time and date for the procedure to be run, and whether you want the job to be repeated. 
See the next section for details. 

2. Select the required options and click OK. 

The selection process begins. While the task is running, a Progress and Information window is 
displayed to keep you informed of progress. 

 

Figure 136: Example of the Executing information page 
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The task may take some time depending on the size of the panelist database and the exclusion criteria set. 
Once the task is complete, if the output file has been created, you can upload the file into a Confirmit 
project. In this case, an Upload button appears in the Execution & Reporting tab. 

When the Execute function is completed, an OK button will appear at the bottom of the task list. 

3. Click OK. 

The Job Information tab opens. 

Note: The sample list you have created will normally now be checked and approved by a manager. 
The manager’s Confirmit access will have been set up by the system administrator, and when the 
manager logs on and opens the job, the Execution & Reporting tab will have two additional 
buttons; Approve and Decline. The manager will check the sample list and will then click the 
appropriate button. Go to section 7.1.6.4.1 for details on uploading a completed sample file into a 
job. 

7.1.6.3.2 How to Set the Execution Time/Date for a Job 

You may want a job to be executed at some time in the future. Confirmit allows you to input a time and 
date for the job to be executed, and define whether or not the job is to be repeated at intervals. Here you 
can also stop a job that has already been input, or reset it to start as soon as possible. Proceed as follows: 

1. In the Execute Job Properties dialog box, go to the Start Time drop-down menu and select 
Schedule for later execution. 

2. Click OK. 

The Recurrence Pattern dialog opens at the Recurr tab. 

 

Figure 137: The Recurrence Pattern dialog 

The options are as follows: 

• Disable task – select this radio button and click Save to disable the selected task. The task will not 
then run. The task is not deleted; you can access it later and restart it. 

• ASAP – select this radio button and click Save to run the task as soon as possible. 

• Time and date fields – set a time and date for when the task is to run, then click Save. 

• Recurring task – select Yes if the task is to recur. Additional options then become available in the 
dialog box. See the next section. 

When you save the settings, the Recurr dialog box changes to show the selected settings. 

 

Figure 138: Example of the Recurr tab when settings are saved 
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7.1.6.3.3 How to Set Up Recurring Tasks 

You may want a job to be repeated one or more times during a defined period. Proceed as follows: 

1. In the Recurrence Pattern dialog, click the down-arrow beside the Recurring Task field and select 

Yes. 

The dialog expands to display additional parameters – see 0. 

 

Figure 139: The dialog with the Recurrence function activated 

2. In the New Start Time fields, set the time you want the first job execution to be performed. 

3. In the Recurrence Pattern Type area, click the radio button corresponding to the frequency required 
for the recurrence. 

The “Schedule” area towards the bottom of the dialog changes depending on the selection made 
here. In this area: 

− For hourly recurrences, type in the rate. For example, if you want the job to be executed every 4 
hours, type 4 into the box. The job will be first executed at the date and time set in the New Start 
Time fields, then will be repeated every four hours. 

− For daily recurrences, type in the rate. For example, if you want the job to be executed every 3rd 
day, type 3 into the box. The job will be first executed at the date and time selected in the New Start 
Time fields, and will be repeated every third day. 

− For weekly recurrences, type in the rate and select the days of the week on which you want the job 
to be executed. For example, if you type 2 into the first box and click in the Monday and Friday 
boxes to select them, the job will be executed every second week; the first time on the Monday, the 
next time on the Friday, the next time on the Monday and so on. 

− For monthly recurrences, type in the day of the month and the rate. For example, if you want the job 
to be executed on the 10th day of every second month, type 10 into the Day box and 2 into the 
Month box. 

4. In the Range of Recurrence fields, set the end-date and time for the recurrences. No recurrences 

will be performed after this date and time. 

5. Click Save to save the settings. 

The Recurr tab changes to display the settings. 
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Figure 140: The Recurr tab showing an example of recurring settings 

Note: If you go out of the dialog before saving the settings, the settings will revert to their default 
values. 

Note: Once you have saved the settings, you can go back at any time to change them or halt the 
task. 

7.1.6.3.4 How to Change the Execution Settings 

1. In the Recurrence Pattern dialog > Recurr tab, click Change. 

The dialog opens. Here you can make the necessary changes as described in the previous section. 

2. On completion, click Save. 

The dialog then shows the new settings. 

See also section 7.6.3.2 for further information. 

7.1.6.3.5 How to Delete a Job from the Execute List 

Once a job is scheduled for execution it will be listed in the Scheduling window. Go to this window to delete 

a job before it is executed. For further details, see section 7.6.3.1 

7.1.6.4 After the Job has been Executed 

The result of the sample selection process is a text file, which is saved on the server. The file includes the 
ID numbers, email addresses and additional information as selected in the Additional Items tab of the 
selected panelists.The following fields in the output file are generated automatically: 

• PanelistId – the unique ID for the panellist. This is the “responseid” when you are in “Single 
Panellist Editor”. 

• JobNumber – the ID of the sampling job that created this sample. 

• SubSampleNumber – the ID of the sub-sample for which each panellist was extracted. 

• GroupNumber – the Group code specified for the various parts of the sample in the sample 
system’s SubSample-tab. 

• test – indicates whether the panellist is real or one created and used for testing. 0 = real, 1 = test-
panellist. 

• mailcode – a random code between 0 and 9 that can be used to send out the panellists in multiple 
email batches from the survey emailing functionality. 

Assuming the manager has approved the sample list, when you next log back into the job’s Execution & 

Reporting tab, the toolbar will contain the buttons as shown below. 
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Figure 141: Example of an approved job 

• Save – saves changes to the tab. The button flashes while the tab has unsaved changes. 

• Remove Job from Panel – undoes the Execution function and resets the panelist database. 

• Change Mail Date in Panel – enables you to change the date on which the survey is to be mailed 

to the respondents. See also section 7.1.6.4.2 How to Change the Panel Mailing Date. 

• Upload – uploads the sample file into a survey project. See section 7.1.6.4.1How to Upload the 

Output File 

• Outputfile Snapshot – opens a window that provides an overview of the first 10 panelists in the 
sample output file. This allows you to check that the file is correct. 

• Add Test Recipient – click to add test respondents to the database. See also sections 7.1.6.4.3 

How to Add Test Respondents to the Database and 7.9 Tester Template List. 

Note: The Execution & Reporting tab has a Preapproved box. Check this box if the list is already 
approved or you have received permission to bypass the normal check procedures. 

7.1.6.4.1 How to Upload the Output File 

1. Click Upload. 

The Upload Sample Properties dialog box opens. 

 

Figure 142: The Upload Sample Properties dialog box 

• Project ID – the ID number of the project into which you wish to load the sample file. 

• Test Database – check to load the data file into a test database such that you can test the survey. 

• Comment – free text field for general comments. 

• Start Time – select when you want the sample file to be uploaded. See section 7.1.6.3.2 for further 

details of the dialogs and procedures. 

2. In the Project ID field, write the ID number of the project into which you wish to load the sample file, 

and make the other settings as required. 
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3. Click OK. 

The file containing the details of the selected panelists is loaded into the selected survey. While this 
is happening, a task list and progress bar is displayed on the screen. On completion, an OK button 
will appear at the bottom of the task list. 

4. Click OK to return to the Job Information page. 

The Sampling job is now complete. Refer to the Confirmit User manual for further information on 

survey creation. 

7.1.6.4.2 How to Change the Panel Mailing Date 

1. Click the Change Mail Date in Panel button. 

The Change Date dialog opens. 

 

Figure 143: Example of the Change Date dialog 

2. Set the date as required. 

3. Click OK. 

7.1.6.4.3 How to Add Test Respondents to the Database 

Once a job has been executed for the first time, the Add Test Recipient button appears in the tab’s toolbar. 
To add a tester template to the database: 

1. Click the Add Test Recipient button. 

The Tester Template List window opens. This window lists all the tester templates available for this 

panel. See section 7.9 for further details. 

2. Select in the list the template you wish to add to the database. 

3. Click Apply and Close. 

The template is added to the database. 

7.1.6.5 The Task Definition Properties Dialog 

Use this dialog to set up recurring jobs, and to view the details of jobs that are already set up to run at 
some point in the future. The tabs in the dialog are: 

• Properties– provides general information on the selected job, and allows you to enter comments 
on the job. 
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Figure 144: Example of the properties tab 

• Recurr – once the settings have been saved, this tab displays the initial settings for the current job 
and the dates and times of any recurrences. 

• Instances – One job scheduled for execution can have several instances (recurrences). The 
Instances tab lists those recurrences that have been completed, and the next recurrence scheduled 
to be performed. Click on the link in the Schedule column to check the details for each recurrence. 

 

Figure 145: Example of the Instances tab 

• Parameters – is for information only. 

 

Figure 146: Example of the Parameters tab 

• Ownership – All tasks have a specified “owner”; in most cases the user who originally created the 
task. However, a user’s access permission can expire or be deleted, and if a task previously 
created by a now-expired/deleted user attempts to run then the task will abort. In this case, the 
administrator has the option of changing the task’s owner. To change the task owner, go to the 
Ownership tab, type in the new owner’s user-name, and save the change. 

Note: To change a task owner, the administrator must have task_admin, system_admin, 
system_project_admin or project_admin permission. Users with other permissions will not see the 
Ownership tab. 
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7.2 Current Matrix 

This window shows the details of the matrix currently selected in the Matrix List. The window contains four 

tabs: 

• General – gives the general details for the matrix. 

• Dimensions – lists the existing dimensions for the matrix, and allows you to create more as 
required. 

• Weights – lists the existing weights for the matrix, and allows you to create more as required. 

• Report – displays a report of the current settings. 

The window opens at the General tab. 

 

Figure 147: The Current Matrix > General tab 

7.2.1 The General Tab 

This tab provides general information about the selected matrix. The tab’s toolbar contains four buttons: 

• Save – saves changes. The button flashes while Confirmit detects unsaved changes. 

• Duplicate – creates a copy of the current matrix. 

• Export Matrix – exports a matrix to another server. 

• Validate Matrix – checks the matrix to ensure it contains no errors. 

7.2.2 The Dimensions Tab 

A Dimension is a set of segments. For example, “Gender” would be a dimension, and within that 
dimension would be the segments (answer options) “Male” and “Female”. 

Go to the Sample Management > Current Matrix window, Dimensions tab. This tab lists the dimensions 

registered for the currently selected matrix. 

 

Figure 148: Example of the Dimensions tab list 

The toolbar buttons are: 

• Save – saves changes for the tab. The button flashes while Confirmit has unsaved changes. 

• Delete – deletes selected Dimensions. 

• Move Up/Down – moves selected Dimensions up or down in the list. 
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• New Dimension – creates a new dimension for the current matrix. 

• Refresh – refreshes the display. This may be required in the event changes have been made to the 
list that are not displayed immediately. 

Click on a Dimension Name to open the Details page for that dimension. 

 

Figure 149: Example of a Details page for a dimension 

The toolbar buttons and data fields are: 

• Save – saves changes for the tab. The button flashes while Confirmit has unsaved changes. 

• Back to Dimension List – takes you back to the list of dimensions registered for this job. 

• Dimension Name – the name of the selected dimension. 

• Collapse Type – sets the action to be performed if Confirmit cannot find the required number of 
panelists using the weights as set. The options are: 

− Nominal – Nominal data is a form of categorical data where the order of the categories is not 
significant. For example industry ("Accommodation, Cafes and Restaurants", "Agriculture, Forestry 
and Fishing", "Communication Services" ,...), gender, ethnicity etc. In shortage scenarios, 
adjustments are accomplished by random selections from the other options. 

− Ordinal – For ordinal data the numbers assigned to the objects represent the rank order (1st, 2nd, 
3rd etc.) of the entities measured. For this type of data, comparisons of greater than and less than 
can be made. In shortage scenarios, adjustments are accomplished by selecting from the options 
nearest to the one that is low. 

− Non-collapsing adjust targets – Confirmit will adjust the total number of panelists selected to 
keep the weight ratios correct. 

− Non-collapsing keep targets – Confirmit will adjust the weight ratios to keep the overall total 
number of panelists correct. 

Note: The number of dimensions and the number of segments within the dimensions will 

significantly affect the time taken to run the sample job. Depending on the composition of the 
panel, it may also become impossible to fill all cells in the matrix. For extreme matrix definitions 
with many dimensions and/or large lists of segments within the dimensions, the sample extract 
may become impossible to perform. 

7.2.3 The Weights Tab 

The segments within a dimension must be weighted. For example, if you are going to use the Gender 

dimension with its Male and Female segments, then you must specify the male-to-female ratio that you 
want in the result. You can create several weighting sets for a dimension, though only one weight set can 
be used on a dimension per sample. 
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Use this tab to create a new Weight set for a dimension, and see and/or edit the details of existing weights. 

 

Figure 150: Example of the Weights tab Weight List 

The toolbar buttons are: 

• Delete Weight – deletes selected Weights. 

• New Weight – creates a new Weight for the current Dimension. 

• Refresh – refreshes the display. This may be required in the event changes have been made to the 
list that are not displayed immediately. 

Click on a Weight Name in the list to open the details page for that weight. 

 

Figure 151: Example of a Weight Details page 

The toolbar buttons and data fields are: 

• Save – saves changes for the tab. The button flashes while Confirmit has unsaved changes. 

• Back to Weight List – closes the details page for the Weight and returns you to the Weight List. 

• Duplicate – creates a copy of the current Weight. The new Weight is given the name Copy of 
(selected weight). 

• Weight Name – the name of the currently selected Weight. 

• Dimension – if you only wish to view one of the dimensions listed, use this drop-down list to filter 
out the other dimensions. Otherwise, select All Dimensions to view all. 
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7.2.4 The Report Tab 

This tab shows details of the dimensions and weights used in the current matrix. 

 

Figure 152: Example of the Report tab 

The tab has the following button in the toolbar: 

• Printer and Save Friendly version – opens a new window containing a printer- and save-friendly 
version of the report. 

The Weights links in the upper section of the tab allow you to jump down to the corresponding detail lists 
for the weight. 

Click the chevron buttons in the header bar for each section (see the Dimension Details bar in the figure 
above) to collapse and expand the section. 

7.2.5 Procedures in the Current Matrix Tab 

7.2.5.1 How to Create a Duplicate of a Matrix 

1. Click the Duplicate button in the General tab’s toolbar. 

A copy of the current matrix is created and its details are displayed in the General tab. 

2. Click in the Matrix Name field and type in a name for the new matrix. 

3. Click Save to save the changes. 

The new matrix is added to the Matrix List. You can now edit the matrix as required and use it in a 
job. 

7.2.5.2 How to Validate a Matrix 

1. Click the Validate Matrix button in the General tab’s toolbar. 

Confirmit checks the matrix and presents a result message as appropriate. 
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Figure 153: Example of a matrix validation error message 

If the matrix is found to be correctly constructed and is approved, the following message is 
displayed. 

 

Figure 154: The “matrix is valid” message. 

2. Click OK to close the message. 

7.2.5.3 How to Create a New Dimension 

1. Click the New Dimension button located at the right end of the Dimensions tab toolbar. 

The Dimension Name dialog opens. 

 

Figure 155: The Dimension name dialog 

2. Type a name for the dimension into the Dimension Name field. 

3. Click OK. 

The Edit Dimension Details window for the new dimension opens. 

 

Figure 156: Example of the Edit Dimension window 
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4. In the variable list (the left column), using the Search function as necessary, find and select the 
variable you wish to add to the dimension. 

The possible values for the selected variable are presented in the second column. These change 
as appropriate to reflect the selected variable. You can add as many variables to a segment as 
required. 

5. In the second column, select the required values for the variable. 

6. In the third column select the required operator and function. 

Note: The operator for the first variable selected must be None. 

7. Click Create New. 

The segments are added to the dimension and are listed in the Segments in Dimension column. 

 

Figure 157: Example of segments in a dimension 

8. Save the changes. 

7.2.5.4 How to Create a Weight Set 

1. In the Sample Management > Current Matrix Weights tab, click the New Weight button located 
towards the right side of the tab toolbar. 

The Weight Name dialog opens. 

 

Figure 158: The Weight Name dialog 

2. Type a name for the new weight into the data field and click OK. 

The Details page for the new weight opens. 
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Figure 159: Example of the Details page for a new weight 

The target column fields are blank and must be filled in. Note that the Total fields (currently red) for 
each set of rows must sum to 100%. When this is correct, the field will turn green. 

3. Type or copy the appropriate values into the Target fields. 

4. Click the down-arrow beside the Dimension field to open a drop down list of the options available, 

and select the required dimension from the list. 

Each Dimension row has a Copy and a Paste button. Click Copy to copy the target weights for the 

dimension to the clipboard. Click Paste for a different dimension to paste the target weights into 
that Dimension’s weight fields. 

5. When all the target weight fields are correctly filled in, click Save to save the details. 

The weight is saved and added to the Weights list. In the event some target weights are not filled in 
correctly, an error message will be displayed. 

7.2.5.5 How to Delete a Weight Set 

To delete unnecessary weight sets: 

1. Go to the Sample Management > Current Matrix > Weights tab, Weights list. 

2. Find the weight set you wish to delete, and click in the corresponding box to select it. 

3. Click Delete Weight. 

A confirmation message box opens. 

4. Click OK to delete the weight, or Cancel to close the message box without deleting the weight. 

7.2.5.6 How to Export a Matrix 

You may wish to export a matrix from the current server so it can be used on a different server. A matrix is 

exported on an email as an .xml file. To export a matrix: 

1. Click the Export button in the General tab’s toolbar. 

The Matrix Export dialog opens. 

 

Figure 160: The Matrix Export dialog 
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The default email address is that of the current user. Change as necessary. 

2. Type any comments into the Comment field. 

3. Click OK. 

The matrix is sent as an .xml file attached to an email. It can now be imported into a different 

server. To import a matrix that has been exported from a different server, see section 7.5.1.2. 

7.3 Job List 

This window lists all the sampling jobs that you currently have “in progress”. Once a job is complete, the 
sample is linked to the survey and the panelists are invited to respond, then the job is moved to the Active 

Job List. See section 7.4 for further information on the Active Job List. 

Use the filters to find the job you are interested in and click on the blue link to select it. You will be taken 
automatically to the Current Job window. 

 

Figure 161: Example of the Job List window 

Note: If you open a job, then return to the Job List and open a different job, an information box 
appears warning you that you are about to change jobs. Click OK to continue and change jobs, or 
Cancel to cancel the change and remain with the current job. 

7.3.1 The Job List Filters 

In an established company the list of registered jobs may run into thousands, and a search through the list 

for the one job that you wish to select for exclusion or relaxation could be time-consuming. Confirmit 
therefore provides you with a set of filters so you can reduce a long list to a manageable size. 

 

Figure 162: The Job List filter bar 

• Job Number – type in the number of the job you are looking for, then click Search. You can use 
wildcards and type in part of the number. For example, type in 123 to find all jobs where the job 
number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the 
number 123 somewhere in the job number, such as job number 45123678. 

• Description – type in the description of the job you are looking for, then click Search. You do not 
need to type in the entire description, and you can also use wildcards. For example, if the job you 
are looking for has the text “Confirmit Customer Survey 1” in the description field, typing in confirm, 
*sur, or even just *1 will find the job. However bear in mind that the simpler the search criteria is, 
the more jobs the search is likely to find. 

• Modified – enables you to search for jobs depending on when they were last modified. Click the 
drop-down arrow beside the operator field and select the required operator, then click on the 
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calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the > operator and a date to list all the jobs that were modified after the selected date. 

• Mailing Date – allows you to search for jobs according to the date on which they were mailed. Click 
the drop-down arrow beside the operator field and select the required operator, then click on the 
calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the <= operator and a date to list all the jobs that were mailed on or before the selected date. 

• Created By – allows you to search for jobs created by specific users. Type the user’s identification 
(as used by Confirmit) into the field, or use standard Windows copy and paste functionality, and 
click Search. 

• Job Type – allows you to search for jobs according to their type. Click the drop-down arrow beside 
the field to open a list of the registered job types, select the desired type and click Search. 

• Company – allows you to search for jobs according to the company under which it is registered. 
Click the drop-down arrow beside the field to open a list of the registered companies, select the one 
required and click Search. 

• Status – allows you to search for jobs according to their current status. Click the drop-down arrow 
beside the field to open a list of the statuses, select the one required and click Search. 

• Alphabetical Filter – the letters of the alphabet are listed along the lower edge of the window. Click 
a letter to show only those jobs in which the Description starts with the selected letter. Click All to 
show all jobs. 

Note: You can use any combination of the above filters to find the required job. For example you 

can perform a search to find all the jobs with a particular status that were modified before a given 
date and that were created by a particular person. You can set all the filters and then perform the 
search, or you can perform separate searches using one filter at a time. 

7.3.2 The Job List Toolbar 

• Search – commence a search based on the selected filter criteria. 

• Delete – delete the selected job(s). 

• New Job – create a new job. 

• Import Job – import a job that has previously been exported, for example when you wish to copy a 
job from another server into this server. 

7.3.3 Procedures in the Job List Window 

7.3.3.1 How to Create a New Job 

This function allows you to create a new job from the bottom up. Note that you can also create new jobs by 
duplicating existing jobs (see the Current Job > Job Information tab section) and by importing jobs from 

other servers (see section 7.3.3.2). 

1. Click the New Job button located towards the right end of the Job List toolbar. 

The New Job Properties dialog box opens. 

 

Figure 163: The New Job Properties dialog box 

2. Type in a unique job number. 

3. Type a description of the job into the Description field. 

Note that the first letter used in this description will be used in the alphabetical filter. 

4. Click OK. 
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The job is created and added to the job list. You can now select the new job and go to the Current Job 

window to set the details and panelist selection criteria. 

7.3.3.2 How to Import a Job 

Use this function to import a job that has for example been created on a different server and exported to a 

file (see also section 7.1.1.3.2). 

1. Click the Import Job button located towards the right end of the Job List toolbar. 

The Job Import dialog box opens. 

 

Figure 164: The Job Import dialog box 

2. Click Browse to open a standard Windows browse dialog box, and find the file you wish to import. 

3. Type a unique job number into the Job Number field. 

4. Click OK. 

The file is imported and added to the Job List. You can now select it in the Job List and go to Current Job 
to edit it. 

7.3.3.3 How to Delete a Job 

Jobs that are no longer needed can be deleted from the system. Note that once a job has been deleted it 

cannot be undeleted, you will need to rebuild it. You can delete any number of jobs simultaneously. 

1. Go to the Sample Management > Job List menu comment. 

The Job List window opens. 

2. Find the job or jobs you wish to delete. 

3. Click in the check boxes for those jobs to select them. 

4. Click Delete. 

The selected files are permanently deleted. 

7.4 Active Job List 

This window lists all the sampling jobs that are currently “in production”. Once a job is complete, the 
sample is linked to the survey and the panelists are invited to respond, then the job is moved to this list 
from the Job List. 

7.4.1 The Search Fields 

You may have a large number of jobs that are active at one time, and a search through the list for the one 

job that you wish to view could be time-consuming. Confirmit therefore provides you with a set of filters so 
you can reduce a long list to a manageable size. 

• Status – allows you to search for jobs according to their current status. Click the drop-down arrow 
beside the field to open a list of the statuses, select the one required and click Search. 

• Date Filter – use to find active jobs based on their dates. Select the “type” of date you are looking 
for, for example the mailing date, select the operator, for example < will give all dates less than 
(before) the selected date, and select a date, then click Search. 

• Days Before Closing – use to find active jobs based on the number of days remaining before the 
survey closes. Select the operator, for example > will give all jobs with more than the specified 
number of days remaining, and type in the number of days, then click Search. 
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7.4.2 The List Columns 

• Job Number – the number of the job. 

• Name – the name of the job. 

• Status – indicates the current status for the job. 

• Project ID – the identification number of the survey project to which the sample is attached. 

• Mail Date – presents the date on which the survey was mailed to the respondents in this sample. 

• Days Before Closing – the number of days that this survey and sample will remain active before 
closing. 

• Survey Owner – the owner of the survey to which this sample is attached. 

• Created By – the name of the person who created the sample. 

7.5 Matrix List 

This window lists all the matrices currently available in your Confirmit database. 

 

Figure 165: Example of the Matrix List 

The list of matrices may be extensive, so Confirmit provides you with a set of filters so you can reduce a 
long list to a manageable size. The filter fields are: 

• Panel Fields – allows you to search for matrices based on specified panel fields, for example all 
matrices with Age as or in a dimension. 

• Name – type in the name of the matrix you are looking for, then click Search. You can use 
wildcards and type in part of the name. 

• Created – enables you to search for matrices depending on when they were created. Click the 
drop-down arrow beside the operator field and select the required operator, then click on the 
calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the > operator and a date to list all the matrices that were created after the selected date. 

• Created By – allows you to search for matrices created by specific users. Type the user’s 
identification (as used by Confirmit) into the field, or use standard Windows copy and paste 
functionality, and click Search. 

• Modified – enables you to search for matrices depending on when they were last modified. Click 
the drop-down arrow beside the operator field and select the required operator, then click on the 
calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the >= operator and a date to list all the matrices that were modified on or after the selected 
date. 

• Modified By – allows you to search for matrices modified by specific users. Type the user’s 
identification (as used by Confirmit) into the field, or use standard Windows copy and paste 
functionality, and click Search. 

• Last Job Used – allows you to search for matrices according to the job they were last used with. 
Type or copy the job ID into the field and click Search. 

• Last Used – enables you to search for matrices depending on when they were last used. Click the 
drop-down arrow beside the operator field and select the required operator, then click on the 
calendar icon beside the field and select the date. When you are ready, click Search. For example, 
select the <= operator and a date to list all the matrices that were used on or before the selected 
date. 

• Summary – shows a summary of the matrix dimensions. 

Note: You can use any combination of the above filters to find the required matrix. For example 
you can perform a search to find all the matrices that were created before a given date and that 
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were created by a particular person. You can set all the required filters and then perform the 
search, or you can perform separate searches using one filter at a time. 

Across the bottom of the window is an alphabetic filter – click a letter to display only those matrices in 
which the Name starts with the selected letter. 

7.5.1 Procedures in the Matrix List Window 

7.5.1.1 How to Create a New Matrix 

1. Click the New Matrix button located towards the upper right corner of the window. 

The New Matrix dialog box opens. 

 

Figure 166: The New Matrix dialog 

2. Type a name for the new matrix into the Matrix Name field. 

3. Click OK. 

The Sample Management > Current Matrix window opens at the General tab. 

 

Figure 167: Creating a new matrix 

You now need to define the dimensions and segments for the matrix. Refer to section 7.2 for further details 

on the tabs and matrix functionality. 

7.5.1.2 How to Import a Matrix 

You may wish to import a matrix from a different server. A matrix is exported from a server as an .xml file 

attached to an email. See section 7.2.5.6 for further details on exporting. 

1. Open the email and save the attached .xml file to a logical folder on your server. 

2. Open Confirmit and go to the Sample Management > Matrix List menu command. 

The Matrix List window opens. 

3. Click the Import Matrix button located in the upper right corner of the Matrix List window. 

The matrix Import dialog box opens. 

 

Figure 168: The Matrix Import dialog box 
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4. Click Browse to open a standard Windows file selection dialog, browse to the .xml file and select it, 
then click Open. 

The .xml file name is added to the File to Upload field. 

5. Type a logical name for the matrix into the Matrix Name field. 

This name will be displayed in the Matrix List window. 

6. Click OK. 

The matrix file is uploaded and added to the matrix list. You can now edit the matrix as required and 

add it to a job. See section 7.2 for more information on editing matrices. 

7.6 Scheduling 

This window lists the jobs that are awaiting execution and those that have been run. To open the 

Scheduling window, go to the Sample Management > Scheduling menu command. 

 

Figure 169: Example of the Scheduling window 

The window contains two lists: 

• Sampling Jobs – the queue of sampling jobs that are waiting to be run. 

• Other Jobs – support jobs, such as importing files or exporting to a different server. 

Both the lists have the following buttons and options: 

• Search – type search criteria into the job number field then click search to reduce the list to only 
those jobs answering to the criteria. 

• Remove – click to delete a selected job from the list. 

• Move Backward – moves the selected job to 1 minute after the next job in the list. 

• Move Forward – moves the selected job to 1 minute before the previous job in the list. 

• View – select Active or Inactive. 

• Refresh – click to update the lists. 

7.6.1 The Sampling Jobs List 

The Sampling Jobs > Active list contains those jobs that are waiting to be run. 

Click the link in the Mail Date column to open the Task Scheduling window for the job. 
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Figure 170: Example of the Task Scheduling window 

This window contains the Recurrence Pattern dialog. Here you can change the recurrence settings, 
disable (delete) the task, or override the recurrence settings and start the task immediately. 

Click Change to open the dialog for access to the recurrence settings. Refer to section 7.1.6.5 for further 

details on the settings and procedures. 

7.6.2 The Inactive List 

The Inactive list contains all the jobs that have been run. The job status column indicates whether the job 

was completed or aborted by the system. A job may be aborted by the system for many reasons, for 
example the system may not be able to find the required number of panelists, or there may be a problem 
with the date or exclusion setup. To view the report for a completed job, click the link in the Log Entry 
column for that job. The Task Log window opens. 

 

Figure 171: Example of the Task Log for an aborted job 
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Figure 172: Example of a log for a completed job 

Go to the Properties tab to see the details for the execution job. 

 

Figure 173: Example of the Properties tab for a job 

In the properties tab, click Task Definition to go to the Task Definition Properties window. This is 

described in section 5.1.1.2.1 Task Definition. 

7.6.3 Procedures in the Scheduling Window 

7.6.3.1 How to Abort Execution of a Sampling Job 

There may be a time when you need to delete a sampling job from the schedule before it has been 
performed. Proceed as follows: 

1. Go to the Sample Management > Scheduling menu command. 

The Scheduling window opens, see Figure 169 for an example. 

2. In the Sampling Jobs list, find the job you wish to delete and click in its checkbox to select it. 

3. Click Remove. 

The job is deleted from the list and will not be performed. 
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7.6.3.2 How to Change the Job Schedule Settings 

After a job has been scheduled, you may need to change the settings. 

1. Go to the Sample Management > Scheduling menu command. 

The Scheduling window opens. See Figure 169. The jobs listed in the Active list are those that are 
scheduled but that have not yet been executed. 

2. Click on the link to the job that you wish to change. 

The Task Scheduling window opens with the Recurrence Pattern dialog. See Figure 170 for an 
example. 

3. Click Change. 

The Recurr tab opens enabling you to edit the settings. 

4. Make the required changes. 

5. Click Save. 

The Recurrence Pattern dialog is updated to show the new settings. 

7.7 Concurrent Sampling 

Note: The Concurrent Sampling functionality is an add-on and is subject to payment 

7.7.1 Background 

In a normal sampling task, each sample is calculated from the available resources (the panelists that have 

not yet been selected for other jobs) with no awareness of the requirements of any following samples. The 
result is that the first samples extracted have first rights to the resources. As later samples are extracted, 
the pool of resources in certain categories may be exhausted leaving none available. The sample selection 
operator would normally attempt to look ahead at the sample jobs in the queue, and make manual 
adjustments to the earlier job specifications so that some scarce respondents will be available for later 
jobs. This process is dependent on the skill of the operator, but is also rather crude and imprecise. 
Furthermore, comparison of such jobs, presumably of equal priority, is very difficult. 

The Concurrent Sampling functionality processes multiple sample selection jobs simultaneously. Each job 
will have a different selection criteria and structure, with different target sample counts, based on output or 
returns, and will make the trade-offs when allocating scarce panel resources. The result in this case will be 
that scarce resources are allocated fairly across multiple sample jobs. 

7.7.2 The Concurrent Sampling Window 

Go to the Sample Management > Concurrent Sampling menu command. The Concurrent Sampling 

window opens as shown in the example below. 
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Figure 174: Example of the Concurrent Sampling window 

The window contains three main areas: 

• Available Jobs – lists the sampling jobs that are currently available to be run. 

− Click in the checkbox beside a job to select the job, then click Add in the toolbar above the list to 
move the job to the Selected Jobs list below. Selected jobs will be grayed out in the Available Jobs 
list. 

• Selected Jobs – the jobs that have been selected to be run in the concurrent sampling task. 

− To remove a job from the Selected Jobs list, click in the checkbox beside the unwanted job and 
click Remove. The job is returned to the Available Jobs list. 

• Execute Job Properties – this area contains properties that you can set for the job that is to be 
executed. 

7.7.3 How to Run a Concurrent Sampling Job 

1. Go to the Sample Management > Concurrent Sampling menu command. 

The Concurrent Sampling window opens as shown in the example above. 

2. In the Available Jobs list, find the jobs you wish to run concurrently and select them by clicking in 
the boxes at the beginning of the rows. 

If the list is extensive, you can search using the Job Number, the Description or the Mailing Date. 

3. Click Add to move the selected jobs to the Selected Jobs list. 

4. In the Execute Job Properties column, select and/or set the required options. 

5. Click Execute. 

In the event you have selected Schedule for later execution in the Execute Job Properties area, a 
dialog will open to allow you to set up the recurrence pattern. Make the appropriate settings and 
save. 

The job will run as specified. On completion, the samples can be handled as “normal”. 

7.7.3.1 The Execute Job Properties 

• Pull to Expected Returns – each panelist can be given a grade for the probability that he/she will 
reply to the questionnaire. This variable must be created as a system field in the panel survey, and 
must be an open numeric object with a value between 0 and 1. The value of the variable will 
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normally be calculated for the individual panelists using a rule, and will be based on the responses 
to previous surveys. The value is used during the sampling process to calculate how many 
panelists must be selected for a sample to ensure that the required number of responses are 
received. When the Pull to Expected Returns property is selected, the Expected Return Variable 
will be used for each panelist when creating the sub samples. 

Note: The Expected Return Variable must be included in the Data Source for the selected jobs. To 

enable this, you must specify an Expected Return Variable on the Sampling Settings page – see 
section 7.10.1. 

• Update Panel – ensure this box is checked if you wish to create a sample and update the 
database. This action will reserve the selected panelists for the job, ensuring they cannot be used 
for other jobs during the exclusion periods. 

Click in the box to deselect it if you wish to perform a “dry-run” of the sample selection process. 

Confirmit will then apply all the expressions and exclusions, will check the system setup, and will 
present a report with all the appropriate information, but no changes will be made in the database 
and the panelists will not be reserved. Use this to test the job setup to ensure you get the required 
panel. You can perform as many dry-runs as you wish. 

Note: If you execute the job with the Update Panel option selected, you can remove the panelist 

reservations from the database afterwards. To do this, click the Remove Job from Panel button that 
appears in the tab’s toolbar. 

• Generate Output File – ensure this box is checked if you require the output file (the list of panelists 
reserved for the job) to be created. 

Note: If you select to create the output file but not to update the panel database, then Confirmit will 
have no record that the selected panelists have been involved with this job. These same panelists 
may then be included in later jobs, and will not be excluded automatically by date and/or category. 

Comments – type any comments into the free-text data field. 

• Start Time – click the down arrow to open a drop-down list of the options available: 

− ASAP – start the job as soon as possible. The job will be queued behind any other jobs awaiting 
processing in the database, and will be run as soon as the processor is available. 

− Schedule for later execution – select this option if you want to run the job execution procedure at 
a later time. If this option is selected, when you click OK, a dialog opens in which you can set the 
required time and date for the procedure to be run, and whether you want the job to be repeated. 

See section 7.1.6.3.3 for details. 

7.8 Multiple Sample Upload 

This menu command enables you to upload several jobs simultaneously. Note that the jobs must have 
been executed. 

1. Go to the Sample Management > Multiple Sample Upload menu command. 

The Multiple Sample Upload window opens as shown in the example below. 
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Figure 175: Example of the Multiple Sample Upload window 

Here you must specify the project the jobs are to be uploaded to. 

2. In the Upload Sample Properties column, click Select Project. 

The Available Survey Project window opens, listing the projects currently available. 

3. Select the project you wish to upload the jobs to, and click OK. 

The Available Survey Project window closes and the project number is added to the Project ID field. 

4. In the Available Jobs list, select the jobs you wish to upload and click Add. 

The selected jobs are grayed out in the upper list and are moved to the Selected Jobs list below. 

5. Click Upload towards the left end of the Multiple Sample Upload window toolbar. 

The task window appears as in the example below. Click the Task ID links to see the details pages 
for the tasks. 

 

Figure 176: Example of the task list 

6. On completion, click OK. 

The task list closes and you are returned to the Multiple Sample Upload window. 

7.9 Tester Template List 

Go to the Sample management > Tester Template List menu command. This window enables you to 
add rows to the respondent database that you can then populate with “dummy” respondent information 
such that you can test the survey and the system setup before you send it out to the actual respondents. 

A Template in this instance is a set of dummy respondent information that you can create and store such 

that it is available to be added to the respondent database when required. 

You can set up any number of such templates for a panel, and add different respondent information to 
each such that you can check different parts of the survey logic. 
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In the event the list is extensive, Confirmit provides a search facility to assist you with finding the template 

you wish to use. This functions in the same way as the other search facilities in Confirmit. 

 

Figure 177: Example of the Tester Templates window 

7.9.1 How to Create a New Tester Template 

1. Click New Tester Template in the upper right corner of the window. 

The New tester Template dialog box opens. 

 

Figure 178: The New Tester Template dialog box 

2. Type in a name and a panelist ID for the template 

3. Click Finish. 

The template is created and the Tester Template page opens. 

 

Figure 179: Creating a new tester template 

You now need to add the dummy respondents to the template. 

4. In the lower part of the page, click Add. 

A row is added to the table. 

5. Type a valid email address into the Email field, and type a group code into the other field. 

This Group Code corresponds to the codes specified in the sub-sample. 

6. Repeat steps 4 and 5 until you have the required number of “Test respondents” in the template. 



Confirmit Community Panels User Guide  Confirmit Confidential 

 

 

 115 

 

Figure 180: Example of a tester template 

7. Click Save to save the changes, then click Back to return to the Tester Templates list. 

You can now add the dummy “test respondents” created in the template to the bottom of the respondent 
database. The respondent data fields for these new rows in the database are then populated by data 
copied from the same number of rows at the top of the database. In this way, the test respondents will 
automatically fulfill the category, date and other requirements such that they are accepted as “members” of 

the sample in the database. To add a template to the database, see section 7.1.6.4.3 How to Add Test 

Respondents to the Database. 

7.10 Sampling Settings 

The Sampling Settings page allows you to set default values and rules for the panel. These settings apply 
only to the panel currently in use. 

Go to the Sample Management > Sampling Settings menu command. 

The Sampling Settings page opens at the General tab. 

7.10.1 The General Tab 

 

Figure 181: The Panel Settings page General tab 
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Use this page to set the default properties for the panel. This page contains the following properties and 
information: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by 
Confirmit when the panel is first created and cannot be changed. 

• Date Elimination Pre Days – this is the default value for the “number of days before mailing date” 

in the date elimination function. See section 7.1.2.3.4 How to Set the Date Elimination Function for 

further information. 

• Date Elimination Post Days – this is the default value for the “number of days after mailing date” 

in the date elimination function. See section 7.1.2.3.4 How to Set the Date Elimination Function for 

further information. 

• Category Elimination Pre Days – this is the default value for the “number of days before mailing 

date” in the Category Elimination function. See section 7.1.2.3.3 How to Set the Category 

Elimination Function for further information. 

• Category Elimination Post Days – this is the default value for the “number of days after mailing 

date” in the Category Elimination function. See section 7.1.2.3.3 How to Set the Category 

Elimination Function for further information. 

• Survey History Include Months – the number of months that items in the survey history will be 
included in the BitStream files used by the sampling process. Type in the desired value. 

• Logging Enabled – enables or disables extra logging of the sampling balancing algorithm’s 
behavior. 

• Set Status of Job to Production… - a job will not normally be given the Production status before 
first real panelist has been invited by email. Check this box to set a job status to Production once 
the sample has been uploaded. 

• Validate Background Variables – check to enable validation that the fields in the sampling file 
exist in the survey to which the sample file is to be uploaded. 

• Job Number Pattern – a regular expression used to determine the legal syntax of a job number. 

• Default Project Filter Length – specifies the length of search-criteria when finding a survey to 
which a sample is about to be uploaded. This property should be used if the survey names 
correspond to Job Numbers. 

• Default Survey Rule Template – the Survey Rule Template that is to be used if no other Survey 

Rule Template is specified based on custom properties. See also section 7.10.6. 

• Default Output Field Template – the Output Field Template to be used if no other Output Field 

Template is specified based on custom properties. See also section 7.10.5. 

• Output Rule – use this to set the formatting rules for a sample file. Here you can specify the format 
for date fields, numeric and Boolean values, and create aliases for the output file headers. Click 

Edit to open the Rule Editor page. See section 6.3 Current Rule for further details on rules. 

• Posting Rule – you can run a panel rule for a specific sample file. For example, if you have a 
survey that requires specific header names for the columns in the sample database, then use this 

rule to change the headers as required. Click Edit to open the Rule Editor page. See section 6.3 

Current Rule for further details. 

• Expected Return Variable – select the variable that contains the panelists’ probability of 
answering a survey. The variable will be a system field in the panel survey, and must be an open 
numeric object with a value between 0 and 1. The value of the variable will normally be calculated 
for the individual panelists using a rule, and will be based on the responses to previous surveys. 
The variable cannot be null for any of the panelists. This variable will be used when Pull To 

Expected Return is selected when running a concurrent sampling job (see also section 7.7.3.1). 

7.10.2 Refresh Survey History Job Information 

If under the Panel Setup > Designer menu command, the Panel Variables toolbox > Survey History 
variables have been added with an ID corresponding to the ID of a custom property for jobs, and the 
Characteristic property is set to LoopSupport, and the custom properties for the jobs have the Has Survey 
History Support property checked, then the Refresh Survey History… button will synchronize values in 
the panel based on existing values in existing jobs. 
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7.10.3 The Categorization Tree Tab 

Use this tab to create and manage a hierarchy tree for the categories used in the panel. The categories 

are defined by the user (company) and used to classify jobs, with each job belonging to one or more 
categories. You can then use these classifications when for example setting up exclusion rules for 

sampling. See also section 7.1.1 Job Information Tab for further information. 

 

Figure 182: Example of the Categorization Tree tab 

To add a categorization or group, in the tree, right-click on the item after which you wish to create the net 
item, and select Add Category or Add Categorization Group from the drop-down menu as appropriate. 

These categorizations will then be available to you when creating and/or editing the current job. 

7.10.4 The Property Definitions Tab 

This tab lists the existing Property Definitions, as shown in the example below. 

 

Figure 183: Example of the Property Definitions list 

The tab allows you to apply your own properties to jobs. Properties can be used not only to categorize 
jobs, but also in for example panel rules. You can specify which of the custom properties, and how many of 
them, are used. 

To edit an existing Definition, click on the blue Name link. The Properties page opens for the definition. 

 

Figure 184: The Property Definitions page 

Here you define new property items and specify their requirements. The selection boxes are: 
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• Is Required – check this box if a job must include this property to be valid. 

• Show in Joblist – check this box to specify that the job is to be included in the job list. 

• Use Output Template – in the Property Item List in the lower part of the page, select the Output 
Template to be used. 

• Use Survey Rule Template – in the Property Item List in the lower part of the page, select the 
Survey Rule Template to be used. 

• Has Survey History Support – allows you to add the value of the custom property to the survey 
history at the time of executing a job. This is so customized properties can be used in expressions 
in Panel Rules later. 

• Use in Elimination – click to use the definition for Property Elimination for the job. Refer to section 

7.1.2.3.5 for further details. 

Note: Only one Property Definition can be used for elimination in a job. Once the Use In Elimination 
box is checked for a Property Definition, the box cannot be accessed for another definition. 

7.10.4.1 How to Create a New Property Definition 

1. On the Property Definitions tab, click the New Property Definition button towards the right end of 
the toolbar. 

The New Property Definition dialog opens. 

 

Figure 185: The New Property Definition dialog 

2. Type a name and an ID for the property into the respective fields, then click OK. 

The Property Definitions page opens as shown in Figure 184. Select the options and add Property 

Items as required. 

3. Save the changes. 

7.10.4.2 How to Define a Property Item 

1. In the Property Item List toolbar, click the Add button. 

A new line is added to the list. 

2. Type in an ID and a name for the new property, then select the remaining options as required (see 
above for definitions). 

3. Save the changes. 

7.10.5 The Output Field Templates Tab 

When a job is run, the output is a text file (respondent list). The job specifies which panelists are to be 

used, and also which columns from the database are to be included. This tab specifies which columns are 
to be included as default. 

To specify any columns that are to be included in addition to these default columns specified here, go to 

the Current Job > Additional Items menu command (see section 7.1.5 The Additional Items Tab ). 
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Figure 186: Example of the Output Field Templates tab 

Click on the blue Name link for a template to open the editing page for that template. 

 

Figure 187: Example of the template editing page 

The available fields are listed in the left column; any fields that are already selected for the template are 
listed in the right column. On completion, save the changes. 

7.10.5.1 How to Create a New Template Definition 

1. In the Output Field Templates tab, click the New Template Definition button towards the right end 
of the tab toolbar. 

The Template Editing page opens. See Figure 187 for an example. 

2. Give the new template a name. 

3. In the Available column, find and select the output fields you wish to include in the template. 

4. Click the >> button to move them to the Selected column. 

5. Click Save to save the changes. 

If this template is later used in a job, then the database columns selected here will automatically be 
included in the output file. 

7.10.6 The Survey Rule Templates Tab 

Use the properties in this tab to specify how information in a survey is to update the panel, and to specify 
which rules are to be used in which event. Three events can be controlled by rules: 

• When and how the database is updated with respect to panelists who have completed the survey. 

• When and how the database is updated with respect to panelists who have not responded to the 
survey. 

• When the survey is to be closed to respondents. 

7.10.6.1 How to Create a New Survey Rule Template 

1. Click the New Survey Rule Template button located towards the right end of the list toolbar. 

The New Survey Rule Template dialog box opens. 
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Figure 188: The New Survey Rule Template dialog box 

2. Type a name for the new rule into the Name field. 

3. Click OK. 

The Rules page opens, enabling you to edit the rules for the template. 

 

Figure 189: The Edit Rules page 

The properties are as follows: 

• Name – the name of the rule. This can be edited as required. 

• Update Completes Rule – the rule to run during normal recurring statusing of the panel based on 
surveys. 

• Update Non Responder Rule – Not all panelists selected for a survey will always wish or be able 
to respond to the survey invitation. This rule is intended to be used to free up panelists who have 
not responded to the survey so they can be used in new surveys. This rule is usually run once 
between the start and closing dates of a survey, on a date specified by the Non Responder Days 
setting below.. 

• Survey Closing Rule – this rule is run when a survey is to be closed (when the survey is 
completed). 

• Update Non Responder Days – the number of days after the start of a survey that the Non 
Responder rule is to be run. 

• Close Days – the number of days after the survey is made available to a sample to when the 
survey is closed – the life of the survey. 

4. Select the rules and type the required values into the fields as appropriate, then click Save or Save 
and Close to input the settings. 
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8 Changes Made to the Survey 

When a panel is attached to a survey, several changes are made to that survey so it can function correctly 
alongside the panel. This chapter describes those changes, and the additional functionality that becomes 
available within surveys run by companies with the Community Panels functionality. 

Note: The changes and functionality described in this chapter will only occur or be available to 
companies with access to the Community Panels functionality. 

8.1 How to Attach a Panel to the Survey 

If your company is using the Community Panels functionality, then before you launch a survey you will 
need to tell it which panel you wish it to use. 

Note: This selection must be made before you launch the survey prior to sending it to your 
respondents. 

1. Within the survey, go to the Project Management > Survey Settings menu command. 

The Survey Settings page opens. 

2. Go to the Web Options tab. 

The Community Panel property is located towards the bottom of the tab. 

 

Figure 190: The Community Panel property 

Type the Panel ID into the field, or 

3. Click the Find Panel button. 

The Find Community Panel window opens, with a list of the panels available to you. 

4. Click on the appropriate radio button to select the required panel from the list. 

5. Click OK. 

The window closes and the Panel ID is added to the field. 

6. Click Save to save the changes. 

Now, when you launch the survey, the selected panel will be attached to the survey. 

8.2 Registering a New Panelist 

A special survey is used to register new panelists. This survey must include two scripting functions while a 

third is optional (though strongly recommended): 

• One function must check the database before the panelist is registered to ensure the panelist is not 
already in the database, and close the survey if he/she is already included. 

• The second function must register the new panelist’s information. 

• The third function can remove the panelist’s details from the survey on completion of the 
registration to prevent the database continually growing as panelists register (as this will waste 
space on the server). 
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Figure 191: Example of a simple Panelist Registration survey 

8.2.1 Checking for Previous Registration 

A panelist must only be registered in a panel database once. The script shown in Figure 192 checks the 
email address of a prospective panelist against the database and closes the survey if the email address 
already exists. If the email address is unique, then a new row is added to the panelist database. This script 
is written into the Email question’s Question Details > Validation tab. 

 

Figure 192: Example of script to check whether the email address already exists 

8.2.2 Updating the Information 

Once a new panelist has completed the survey, the information he/she has provided must be uploaded to 
the database. The “update” script shown in Figure 193 performs this function. 

 

Figure 193: Example of the database registration script 

8.2.3 Remove Respondent Data from the Survey 

Once the database is updated, the script example in Figure 194 deletes all the current respondent 
information from the survey (not the panelist database) to prevent database overload, and then redirects 
the survey. The redirect script is required to prevent the survey returning an error when it notices that it 
contains no data for the current respondent. 

 

Figure 194: Example of script to delete the information from the survey 

 

8.3 Updating Existing Panelist Information 

Special surveys are used to update the panelist information. These surveys will need to contain a number 
of scripting objects that are used to perform particular functions within the panel database. 
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Figure 195: Example of a simple Panelist Update survey 

8.3.1 Fetching the Existing Information 

When a panelist wishes to update his/her information, the first operation the survey must perform is to 
fetch the existing data from the database. This will then be used to populate the survey so the panelist can 
see the current information. 

The first object in the survey will therefore be a script object to fetch the data. This will need a script, for 
example that shown in Figure 196. 

 

Figure 196: Example of script to fetch the data from the database 

8.3.2 Updating the Existing Information 

As when registering a new panelist, the database must be updated with the information. This will require 
an “Update” script object in the survey, containing a script such as that shown in Figure 197. 

 

Figure 197: Example of script to update existing panelist information 

8.3.3 Remove the Respondent Data from the Survey 

As when registering a new panelist, once the database is updated, the current respondent information 
must be removed from the survey to prevent database overload. And again, a redirect script is required to 
prevent the survey returning an error when it notices that it contains no data for the current respondent. 

 

Figure 198: Example of script to delete the response and redirect 

8.4 Updating the Survey History Variables 

You can update values in a survey history record. The only requirement here is that the survey includes a 
variable field called PanelistID. 
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Figure 199: Example of script to update the Survey History Record 

8.5 Standard Surveys Associated with a Panel 

A regular survey is associated with a panel as described in section 8.1 How to Attach a Panel to the 

Survey. An association from a job to a survey is created when the sample is uploaded to the survey using 
the job upload functionality within sampling. A survey is not regarded as “Open” for panelists before the 
invitations have been emailed, unless the job status has been specifically set to “In production” in the 
sample system. 

There are two ways to status the information from a survey back to the panel: 

• Standard real-time update – some fundamental fields in the panel are maintained continually up-
to-date. These fields include the status of the survey, Start Date and Completed Date. 

Note: Confirmit On-Premise customers can switch off the real-time status functionality at site level. 

• Survey rules – this uses batch processing, usually set up to run as a recurring task. Survey rules 
provide much improved flexibility concerning how the panel status is maintained. 

Note that both real-time statusing and batch statusing can be used simultaneously. Batch statusing 
(explained in previous chapters) can be specified to update the panelist fields and survey history fields 
based on information in the survey, panelist level information, survey history level information and limited 
information from the job. Surveys using batch statusing have an additional requirement; the survey must 
include two “background” variables named 'JobNumber' and 'PanelistId'. Both these are open-text 
variables with a field width of 255 characters. 
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